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1 Introduction

This operating manual enables you to operate this automatic feeder machine safely as

intended.

> Have the end user provide you with the operating manual for the automatic feeder, the op-
erating manuals of all additional equipment to be connected and the safety data sheets for

cleaning agents.

> Carefully read all operating manuals and safety data sheets before starting up the automat-

ic feeder for the first time or restarting it.

> Observe all of the warnings and safety instructions in these operating manuals and safety

data sheets at all times.

1.1 Automatic feeder versions

The following automatic feeder versions are available:
® Powder - for the use of milk substitute (MP).

® Combi - for the use of milk substitute and fresh milk.
® Fresh milk - for the use of fresh milk.

All automatic feeder versions can be equipped with a variety of pieces of peripheral equipment

and options.
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1.2 Automatic feeder overview

1.2.1  Front and right side view of automatic feeder

0 N OO 0o~ W N PP

Milk powder container

Outlet valve (not shown here)

Milk powder discharge

Water supply

Mixer jar

Rod electrode

Hose connection from mixer to station valve

Mixer motor

9 Water connection

10 Temperature sensor

11 Point electrode for 500 ml portion
12 Right door

13 Ground connection screw

14 Main switch

15 Hand terminal
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1.2.2

Left side view of the automatic feeder

The name plate is located above the left side door on the outside of the automatic feeder. It
contains information about the manufacturer, type and number of the automatic feeder, infor-

mation about connecting the feeder to the power supply as well as its certification.

Name plate

FéRSTER MADE IN GERMANY
- "W TECHNIK CEJ'—“
e, Rensiay

Type: TAPS-VS1-50 400V

2— Py, Date: 36/2015
Voltage: 230/400VAC Freguency: 50Hz
Phases: 3 ITheatingg 125A
3— PP pmax: 5480w
Imax: 1254

Name and address of the manufacturer
Type and number of the automatic feeder

Information on the connection to the power supply

A W N P

The automatic feeder's certifications
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Behind the left side door

a b~ W NP

Storage container for detergent (optional)
Detergent pump (optional)

Mixer drain valve

Feeding box valve(s)

Feeding pump
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1.2.3

Boiler with heating circuit

a A W N B

/4

Hose connection for water pipe
Pressure-reducing valve
Water meter

Boiler water valve

Boiler

6 Mixer

7 Feeding box valve

8 Hose connection between feeding box valve and teat
9 Mixer drain valve

10 Feeding pump
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1.3 Technical data

1.3.1 Electrical connection

Note: The specifications for the electrical connection to your automatic feeder are on its name

plate above the left side door on the outside (see 1.2.2 Left side view of the automatic feeder,

page 9).

1.3.2 Dimensions of the automatic feeder

1150 mm
~930 mm ~610 mm
~635 mm ~520 _mm
—‘___' H-H-:::“.‘: g —_‘II_——_
ﬁ\é
L -
£
[? £
N N
S u
] 1
]
AN
(] |
| |
L
[T
)
[2 @ |
I 3 .
S = S hs .
= ~
~370 mm ~345 mm

Depth when the fly screen door is opened ~ 690 mm

1.3.3 Weight

Approx. 80 kg.

1.3.4 Water connection

Water is connected via a 3/4 inch hose and with a 3/4 inch screwed connection.
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1.35

1.3.6

14

15

151

The water should be of drinking water quality. Please bear in mind that high cal-
cium, iron and manganese concentrations cause premature wear. In these cases it makes

sense to install appropriate filtration systems.

The water pressure on site must be between 1 and 6 bar.

Milk powder container
The milk power container with attachment holds approximately 35 kg of milk substitute.
Number of feeding stations and animals
Feeding stations Calves per feeding station Calves per device
Max. 4 Max. 32 Max. 128

Disposal
All components, liquids and solids must be disposed of in compliance with the official local reg-
ulations for waste prevention and appropriate waste recycling or disposal which apply in your
country. Also observe the relevant safety data sheets.

Symbols and abbreviations

Symbols

Optional: A white plus sign on a black background indicates that optional functions or

equipment are being described.
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1.5.2 Abbreviations

Abbreviation Meaning

abs. Absolute

add. disp. Additive dispenser

Ad lib Ad lib

bo Boiler

C Concentrate

Clean teat Clean teat

clo.? Close?

conc./concentr. Concentration

det. pump Detergent pump

dos. Dosage

dra.v. teat Drain via teat

Drnk spd. Drinking speed

dr. time Drain time

El Electrode

electrol. Electrolyte

f 40FIT period

F 40FIT feeding principle
fd.sensor Feeding sensor
feed.pump Feeding pump

gradient Gradient control

gr. A (B) Group A (B)

ho. Hose

IFS-4 Intelligent feeding station feed, quadruple compact unit
IFS KF Intelligent feeding station concentrate
IFS TR Intelligent feeding station feed
Incr./Red. Increase/reduction

\ Interval feeding program
MAP Manual feeding pump
max Maximum

Min. temp. Minimum temperature
mixer cl. Cleaning the mixer
mixer dr.valve Mixer drain valve

mix. full Mixer full

MP Milk substitute

n. Not

No. Number

out. pause Dispensing pause

P15 Periods 1 -5

R rationed feeding principle
rel. Relative

save amt. Amount saved up

servo Servo control

sw.off del. Switch-off delay

sw. on del. Switch-on delay

Temp. Temperature

TR Feeding box

w/add. or w/addiv. With additive
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w/o add. or w/o add.

Without additive

w/o entitlement

Without entitlement

water bo.

Boiler water

w. entitle.

With entitlement
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2 Important safety information
This chapter outlines:
® The hazards caused by your automatic feeder and how to avoid them.
® The safety labels attached to the automatic feeder and what they mean.
® How to safely install the automatic feeder.

The automatic feeder is state of the art and is produced in compliance with recognized safety
regulations. However, hazards and adverse effects may arise when using it. Both warning
signs directly on the automatic feeder and warning natices in this manual provide warning of

these hazards.

2.1 Intended use

The automatic feeder may only be used to prepare, heat, and dispense liquid feeds, for exam-

ple milk, for calves.

2.2 Necessary qualifications

Only trained service technicians are authorized to install the automatic feeder, put it into ser-

vice and perform maintenance and repairs on it.

Service technicians are specialists with the appropriate qualifications. They are able to assess
the work assigned to them and detect potential risks on the basis of their technical training as
well as their knowledge of the relevant standards. They are familiar with the relevant accident
prevention regulations, generally accepted safety regulations and country-specific standards

and provisions.

2.3 Residual risk which can arise from the automatic feeder

2.3.1 Hazards to health caused by the automatic feeder:

The automatic feeder is electrically powered. You must observe the general pre-

cautions for handling electrical equipment:
® Read the operating manual before operating the automatic feeder.
e Keep children away from the automatic feeder.

® Do not touch any moving parts of the automatic feeder, for example the mixer blades.
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Only use genuine spare parts from the manufacturer.

Turn off the automatic feeder and disconnect the power plug before carrying out any main-

tenance or cleaning work on the automatic feeder.

If the end user intends to operate the automatic feeder outside of closed spaces, inform the
user that he/she must protect the automatic feeder from rain and moisture, for example with

a roof.
The following specific hazards are associated with the automatic feeder's electrical system:

. Electrical breakdown. If there is an electrical or voltage breakdown, electric current
flows through parts of the automatic feeder that are normally insulated. Touching the
unit can cause a fatal electric shock. The automatic feeder must be checked regularly
for electrical safety in compliance with national regulations (repeated inspection).
Make sure that a 30 mA residual current device (RCD) is installed.

. Short circuit, indirect contact. If there is a short circuit, current at many times the
level of the operating current can flow. Touching the unit can cause a fatal electric
shock. Make sure you install a fuse (provided by the customer) corresponding to the
rating on the name plate and a 30 mA residual current device (RCD) in compliance

with local regulations.

The solenoid valves and the pipes to the valves can reach temperatures of up to 70°C.
Touching them can cause burns. Do not touch the solenoid valves and pipes during opera-

tion.

Liquid at temperatures of up to 70°C can spray out of the pipes to the valves. This can cause
scalding. Do not touch the pipes during operation. Carry out the recommended mainte-

nance on the hoses.

The mixer and powder supply may start up unexpectedly if a calf which is entitled to feed
approaches the unit. This can crush or chop off fingers or hands. Never reach into the area
of the mixer or powder supply while the automatic feeder is in operation. Only use the scrap-

er supplied to clean the powder discharge opening.

Poisoning. Additives that are fed to the calves may contain substances that are hazardous
to human health. Avoid direct contact and always wear protective gloves and goggles when

handling these substances.
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2.3.2

e Chemical burns. The cleaning agent used to clean the automatic feeder contains caustic
substances. These can cause severe injuries to the hands or eyes. Avoid direct contact and
always wear chemical-proof protective gloves and goggles when handling the cleaning

agent.

® Excessive strain. The automatic feeder weighs 80 kg. Never attempt to carry it by yourself
as this can cause excessive physical strain.
Material damage caused by the automatic feeder

The automatic feeder can cause the following types of material damage:

® Infection. Improper cleaning or incorrect operation can result in calves becoming infected
by pathogens from the automatic feeder. This can lead to medical costs or to the death of

the calves.

e Corrosion. Improper cleaning or maintenance can result in the automatic feeder ceasing

to function correctly.

® | oss of stability. The automatic feeder must be set up on a level surface. Otherwise, the

automatic feeder can tip over and suffer damage.

2.4  What hazard warnings are provided?

24.1

Hazards are indicated directly on the automatic feeder by safety labels (warning signs, instruc-
tion and prohibition notices), and in the operating manual by specially marked hazard descrip-

tions.

The warnings for hazards that can cause death or injury to people are emphasized more than

those for material damage, for example through the colors, hazard words or symbols used.

Safety labels are an important element of the overall automatic feeder safety concept. They

provide warnings about hazards and explain how to avoid them.

Make sure that all the specified safety labels are fitted to your automatic feeder and that they
are in a legible condition. If the safety labels are difficult to read, replace them immediately.
New safety labels are available from Forster-Technik GmbH.

Components of a hazard description

A hazard description is always made up of the following elements:
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2.4.2

243

The hazard word (Danger, Warning, Caution, Attention).

® The nature of the hazard (what could happen?).

The location of the hazard (where can it occur?).
® The actions to take to prevent the hazard (what do | need to do?).

Hazards causing death or injury

Depending on their severity and the probability of them occurring, hazards that can cause
death or injury to people are indicated by a hazard symbol A\ (warning triangle with exclama-

tion mark) and the following hazard words:

® The word DANGER indicates an imminent hazard that will lead to death or serious injury.
. Warning signs on automatic feeder: DANGER (white text on red background).
. Operating manual: (white text on black background).

¢ The word WARNING indicates a potentially hazardous situation that could lead to death or

serious injury.
. Warning signs on automatic feeder: WARNING (black text on orange background).
. Operating manual: (white text on black background).

® The word CAUTION indicates a potentially hazardous situation that could lead to minor in-

jury.
. Warning signs on automatic feeder: CAUTION (black text on yellow background).
. Operating manual: (white text on black background).

Material damage

The word Attention indicates possible material damage. The automatic feeder or an object in

its vicinity may be damaged, for example a calf.

® Prohibition notice on the automatic feeder: a pictogram crossed out in red in a white circle

with a red border indicates something you are not allowed to do.

® QOperating manual: (white text on black background).
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2.5

251

Safety labels on the automatic feeder

Different safety labels are attached at the hazardous points on the automatic feeder. Warning
signs, prohibition and instruction notices.
What are warning signs?

Warning signs consist of:

® A pictogram in a yellow triangle illustrating the potential hazard.

What are prohibition notices?
Prohibition notices show a pictogram of the prohibited action in a red crossed out
‘ circle. See adjacent example. They illustrate what you are not allowed to do. In
=> the example, the crossed out hose means that you are not allowed to use high
pressure cleaners.

What are instruction notices?

Instruction notices show a pictogram of what you are being instructed to do in a
blue circle. They illustrate what you have to do. In the example, the pictogram

means that you must always disconnect the plug first.

Other labels

Grounding label You will see this label at the points where you have to ground

| the equipment.

Warning signs on the machine

Danger of death by electric shock

-
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Burns / scalding

Health hazards due to additives

A

Chemical burns caused by cleaning agents

A

Automatic startup

Do not spray the equipment down




Important safety information 23

Grounding label

2.6 Safety equipment on the automatic feeder

The automatic feeder may only be operated if the safety equipment is complete and intact. The

automatic feeder has the following safety equipment:
® Safety signs (warning signs, instruction and prohibition signs).

® The heater's safety temperature limiter. This shuts down the heater in the event of overheat-
ing (temperature rises above 70°C). The heater may only be reactivated by a service engi-

neer.

e Safety grid for the powder hopper attachment. The safety grid prevents people from being
injured by the rotating tools in the hopper, for example when adding milk powder. It must
always be installed when the unit is operating.

® The scraper next to milk powder discharge. The powder discharge opening may only be
cleaned with the scraper. This prevents finger and hand injuries caused by the powder con-

veyor starting up automatically.

The safety devices at the machine are an important part of the safety concept and help prevent

accidents.

® Do not remove or change the safety devices without observing the corresponding safety in-

structions.

® Put the machine into service only after all safety devices have been attached and are in pro-
tection position.
Safety temperature limiter

The automatic feeder's heater is equipped with a safety temperature limiter which will be trig-

gered in the event of overheating (70°C) and which will then shut down the heater.

The safety temperature limiter is triggered if the water gets too hot or if the heater is running

dry. It can be found behind the cover illustrated below.
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1 Cover of the safety temperature limiter

Safety grid for powder hopper attachment

The protective grid for the powder hopper attachment prevents you from being injured by the

rotating tools in the powder hopper, for example, when filling in milk powder.

1 Protective grid

There is a risk of injury due to rotating tools. The safety grid must always be

installed when the unit is operating.

Scraper next to milk powder discharge

The powder discharge opening may only be cleaned with the scraper. This prevents finger and

hand injuries caused by the mixer starting up automatically.
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1 Mount for scraper

2 Scraper

There is a risk of injury due to automatic start-up. Do not reach into the hazardous
area of the mixer. The mixer can start up automatically at any time, crushing or cutting off your
fingers. Always turn off the automatic feeder using the main switch and disconnect the power

plug. Only use the scraper supplied to clean the powder discharge opening.
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3 Commissioning

Have the end user provide you with the operating manual of the automatic feeder, the separate
operating manuals of additional equipment to be connected as well as the safety data sheets

for the cleaning agents.

The appendix contains a check list of all instructions that you must observe during the initial
startup or restart process. (see 9.1 Checklist for commissioning and recommissioning,
page 133).

3.1 Setting up the automatic feeder

> When setting up the automatic feeder, observe the occupational safety measures.

Beware of the health hazards caused by lifting heavy loads Never carry the

automatic feeder by yourself.

> Always set up the automatic feeder on an even surface.

Note: Using its adjustable feet, if necessary, you can level the automatic feeder.

> Set up the automatic feeder in a frost-free location. If this is not possible, inform the end
user that he/she must protect the automatic feeder from frost using additional equipment
such as the additional frost protection equipment or suction hose heating made by Forster-
Technik.

> If the end user intends to operate the automatic feeder outside of closed spaces, inform the
user that he/she must protect the automatic feeder from rain and moisture, for example with

a roof.
> Make sure that there is a drain where the automatic feeder is set up, for the cleaning water.

> Adjust the length of the drain hose. He must be kept as short as possible.

Make sure that the drain hose is not bent or laid in loops to avoid that it is dam-

aged.

> Observe the manufacturer's instructions and national regulations for use, storage and in-

stallation site of the cleaning agent used (option).

> Inform the user that the automatic feeder and its cables must be protected from exposure

to sunlight.
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3.2 Electrical connection provided by the customer

The automatic feeder needs its own power supply.

® The power supply must meet the voltage and frequency specifications. The mains supply

must correspond to the supply voltage stated on the left side of the automatic feeder.

® A residual current device (30 mA) in the power supply provided by the customer is compul-

sory for the operation of the automatic feeder.

® Since it is not technically possible to protect the automatic feeder separately against light-
ning, you must inform the end user that he/she must provide the appropriate lightning pro-

tection (e.g. lightning protection system for the entire building).

® Comply with the local regulations and safety measures.

Grounding

To protect the animals and prevent electrical faults, all metallic objects, such as water pipes,
feeding station, stand partition and automatic feeder must be grounded. These locations are
indicated by the grounding label (see 2.5 Safety labels on the automatic feeder, page 21). The
connecting screw to ground the automatic feeder is on the right-hand side of the machine

housing, directly next to the electrical connection cable. Connect this screw to the local ground

via a short, flexible copper cable (minimum cross-section of 4 mm?).

3.3 Water connection

1 Water connection
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3.4

341

> When connecting the automatic feeders, observe the national regulations about protection

of drinking water.

> Inform the end user that the supplied water must be of drinking water quality.

The water should be of drinking water quality. Please bear in mind that high cal-
cium, iron and manganese concentrations cause premature wear. In these cases it makes

sense to install appropriate filtration systems.
> Use a separate water shutoff valve to supply water to the automatic feeder.

> Make sure the water pressure is constant. The water pressure must be at least 1 bar. The
maximum pressure must not exceed 6 bar. If the water pressure drops below 1 bar for a

longer period or permanently, then you will have to install a pressure increasing device.

> Make sure that the water pipe has a sufficiently large cross section. Determine the number
of points where water is simultaneously being extracted and adjust the cross section of the

water pipe accordingly.

Installing feeding stations

Installing feeding station

Install the teat at its intended location on the front plate, 10 to 15 cm above the suction hose
connection of the mixer and the resulting 50 to 80 cm above the calf's floor level. The corre-

sponding suction bracket with splash guard must point downwards.
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3.4.2

3.5

w

v

50-80 cm

The suction hose may not be longer than two meters Otherwise, the calves will
have problems sucking in the feed. This can lead to malnutrition. Malnutrition can cause
impaired growth and development, increased susceptibility to illness or even the death of your

calves.

There is a risk of infection due to feed building up in the hose. The hose between
the teat and the mixer jar valve (rationed mode) or mixer jar (ad lib mode) must not sag and
must be installed at a gradient to the automatic feeder (see the illustration).

Installing stand partition

Install the stand partition in accordance with the manufacturer's instructions.

Attaching the pushbutton/remote control for manual feed start

The pushbutton/feeding button activates the feeding pump. The feeding pump helps habituate

animals to automatic feed consumption and stimulate weak calves to consume feed.

Risk of injury and death. During assembly, make sure that all supplied electrical
components are assembled outside the animal area, otherwise they could be damaged. Oth-
erwise, significant material damage could occur as well as serious injuries to animals and

humans or even death.

> |nstall the pushbutton or the remote control near the feeding box.
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3.6

3.6.1

Connecting antennas

Installation of antennas

There is a risk of the antenna cables being damaged. Install the antenna cables
so that they cannot be damaged by the animals. Observe the separate operating manual for

the antennas.

Install the antennas as follows:

3.6.2

> Keep the distance between the antenna and transmitter as small as possible, no more than

15 - 25 cm. The range of the antenna is, depending on the version, 15 - 25 cm.

> If necessary, block the area next to the feeding box. This is the only way to prevent a
situation in which feed for a calf outside of the feeding box is prepared but the calf

does not receive it.

There is a risk of malnutrition if calves do not receive any feed. Malnutrition can
cause impaired growth and development, increased susceptibility to illness or even the

death of your calves.

> Check the range of the aerials using the aerial test (see 8.2.3 Identification, page 116).

Note: If two calves are identified simultaneously by one aerial, animal identification is inter-

rupted for both calves.

> The distance between 2 antennas should be approx. 100 cm to avoid any range over-

lapping.

> In case double or misidentification occurs, shield the antennas using grounded metal

plates.

Note: In order to use winter feed plans, a MultiReader detector with a temperature sensor
must be installed at feeding box 1. From January 1, 2013 every MultiReader detector is
equipped with this sensor by default. You can check whether your MultiReader detector is
equipped with a temperature sensor under Feeding > Plans > Winter feeding plans (see the

chapter "Feeding > Winter feeding plans" in the automatic feeder's operating instructions).

Squelch values and identification ranges

The approximate range of the antennas is 15 - 25 cm.
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The version of the antenna is crucial for the identification range. With Nedap micro-identifica-

tion, you can set the range via the squelch value.

The squelch values and the identification ranges for the various identification systems are

listed in the following table. These squelch values are based on experience and are set at the
factory.

If the actual values differ, the settings can be changed in the setup (see 5 Setup, page 73).

System Squelch (default values) | Identification range
Collar

0 15-20cm
(X-responder)
Collar

180 15-20cm
(PM-responder)
Earmark (also in the collar)

0 15-20cm
(Nedap system)
Earmark (also in the collar) _

Inactive 15-20cm

(Tiris system)

3.6.3 Connecting antenna cables

Danger of death by electric shock. The electrical components of the automatic
feeder are live. Turning off using the main switch does not disconnect the voltage to the unit.
Always turn off the automatic feeder using the main switch and disconnect the power plug

before you connect the antenna cables.

1

2 |4

3

1 Cable of the hand-held terminal 3 Antenna cable of feeding station 2
2 Antenna cable of feeding station 1 4 Cable clamps

Connect the antenna cable as follows:

1. Turn off the automatic feeder using the main switch and disconnect the power plug.
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2. Connect the antenna cables to the connections provided.

1 Antenna connections

3.6.4  Connecting Ethernet cables

Danger of death by electric shock. The electrical components of the automatic
feeder are live. Turning off the unit using the main switch does not disconnect the voltage to
the unit. Always turn off the automatic feeder using the main switch and disconnect the power

plug before you connect the Ethernet cable.

Connect the Ethernet cable as follows:

1. Remove the dummy plug on the feeder housing.

1 Dummy plug

2. Open the left side door of the automatic feeder.

3. Remove the cylinder with the Ethernet connection from the bracket on the feeder housing.
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1 Cylinder with Ethernet connection

4. Remove the plugs from the seal and open the screw connection of the cylinder.

1 Sealin cylinder

5. Remove the cable sleeve from the cylinder and attach it at the location of the dummy plug

in the feeder housing.
6. Guide the end of the unattached Ethernet cable through the cable sleeve.

7. Screw on the other end of the cylinder and pull out the socket and the Ethernet cable of the

automatic feeder.

1 Socket

2 Ethernet cable of automatic feeder
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8. Place the unattached seal and the screw connection around the unattached Ethernet cable

and connect the end to the socket.

1 Screw connection 3 Screw connection

2 Ethernet cable 4 Seal

9. Insert the cable connector into the cylinder and tighten the cylinder and seals.

10.Push the cylinder into the bracket into the housing of the automatic feeder.

3.7 Installing the safety grid for the powder hopper attachment

Install the safety grid as follows:

1. Turn off the automatic feeder using the main switch and disconnect the power plug.

2. Remove the bag with the small parts and hoses as well as the operating manual from the
powder hopper.

3. Insert the safety grid for the powder hopper attachment.

4. Screw in the three self-tapping screws into the holes provided.

3.8 Switching on the condensation prevention heating for powder discharge and
frost protection equipment

Danger of death by electric shock. The electrical components of the automatic
feeder are live. Turning off the unit using the main switch does not disconnect the voltage to
the unit. Always turn off the automatic feeder using the main switch and disconnect the power

plug before you switch on the vapor barrier.

If the automatic feeder is equipped with a vapor barrier for the powder discharge and/or frost

protection equipment, you must check whether the respective switches on the processor board
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are switched on. If not, you must turn on the switches. You can set the vapor barrier switch to

0 during summer.

2

S1

S2 = switch for frost protection equipment
S1 = switch for vapor barrier for powder discharge

3.9 Filling the powder container

1. When filling the milk powder hoper observe all labor safety precautions.
Beware of the health hazards caused by lifting heavy loads. Make sure that
you do not overload when filling the milk powder hopper. Corresponding auxiliaries may be

necessary.
2. Fill the powder container with milk powder (MP).

There is a risk of malnutrition if calves powder container are empty. Malnutrition
can cause impaired growth and development, increased susceptibility to illness or even death
of the calves. Inform the user that he/she must immediately refill an empty powder container

or he/she must provide the calves with feed using an alternative method.

3.10 Installing the external detergent supply line (option)

Depending on the model, the automatic feeder is equipped with an external detergent supply

line.

Observe the manufacturer's instructions and national regulations for use, storage and instal-

lation site of the cleaning agent used.

Chemical burns due to the cleaning agents used. The cleaning agent can cause

chemical burns to your eyes or hands. Always wear safety glasses and safety gloves when
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working with cleaning agents. Observe all safety instructions listed in the safety data sheet of

the cleaning agent and wear the safety equipment required there.

The detergent container must be placed so that it cannot tip over and calves,

unauthorized persons and children do not have access to it.
The detergent dispenser can be freely selected. Proceed with the installation as follows:
1. Drill a hole (820mm) for the detergent lance into the lid of your detergent container.

2. Insert the detergent lance from below into the lid of your detergent container. Mount the up-

per threaded connection from the top onto the lance and secure it.

]

Note: the height of the sensor can be adjusted by loosening both threaded nozzles.
3. Unscrew the angle nozzle of the suction lance and remove the upper threaded connections.

4. Attach the transparent hose leading out of the left grommet at the rear of the automatic feed-

er to the cap of the angle nozzle.

5. Connect the cap to the angle nozzle and reattach it to the detergent lance.
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6. Connectthe cable of the detergent lance to the cable end (fifth or sixth connection counted

from the top) on the left side of the automatic feeder.

7. Fix the detergent lance through the lid in your detergent container.

P EE—
Note: Small vent holes in the lid prevent the contraction of the detergent container. Please

refer to the manufacturer's instructions and national regulations.

8. Place the detergent container in the place provided for it.

3.11 Switching on the automatic feeder

Connect the power plug and turn on the automatic feeder again using the main switch. Use

the hand terminal to control the automatic feeder.

Note: After the hand terminal has been switched on, the version of the hand terminal's pro-
gram first briefly appears in the display, before the automatic feeder carries out a test routine.

Do not press any buttons on the control panel during these initial routines.
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3.12 Filling the boiler
1. In the display, you can see the fault message Boiler not filled. Press ’;
2. Confirm Fill boiler? by choosing @

3. The boiler will be filled with water.

3.13 Reconfiguring everything

During the initial startup and restart process for the automatic feeder, the program (software)
must be completely reconfigured (reset). This will remove superfluous data as well as outdated

or incorrect settings from the memory.

Note: Choosing New installation deletes the animal data (group membership, barn transfer
date, feeding days, consumption sums), the transmitter numbers are set to zero and the

device data and the feeding plans are overwritten with default values.

Reconfigure all menus as follows:

1. Choose EDQ > Device data to go to the New installation submenu.
2. Confirm Everything by choosing W
3. Confirm Reinstall everything? by choosing \T‘

4. Confirm the security prompt Do you really want to restore the data to factory settings?
by choosing &™".
The message New installation completed! will appear.

5. Confirm New installation completed! by choosing @

All data has been reset to factory settings.

Note: The settings in the feeder setup are not changed by new installation .

3.14 Setting offline mode

You define a period in the Autostart menu option on the offline screen. The default setting is

20 minutes.

You set the autostart as follows:

1. Go to offline mode by pressing ’;

2. The following appears in the display:
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. Start automatic?
. Time
. Date

. Autostart
3. In the Autostart menu, press ™.

4. Choose the maximum duration of offline mode during an extended period of inactivity of

the automatic feeder.

Note: The automatic feeder will automatically return to automatic mode.

3.15 Setting the portion

Feed temperatures that are too low can cause digestion problems in calves and
feed temperatures that are too high can cause gastritis in the abomasum. The temperature of
the feed in the mixer jar must correspond to the mixing temperature specified by the MP man-

ufacturer. Keep to the feed temperatures recommended in this operating manual.

In the device data menu (see 4.5 Device data, page 58) you can make the following settings

for the feed portion:

® Adjust the set temperature of the feed in the mixer jar (see 4.5.3.1 Setting the set and min-

imum temperature, page 61 and following pages).

® Set the minimum temperature of the water in the boiler (see 4.5.3.1 Setting the set and min-

imum temperature, page 61 and following pages).

® Set a pause between the dispensing of two portions (see 4.5.3.2 Dispensing pause,

page 62).
® Set the parameters for the mixer’s draining, emptying and for its OFF delay (see 4.5.3.3
Mixer draining, page 62 and following pages)
3.16 Setting operating modes

You set the operating modes for the automatic feeder in the Device data menu (see 4.5.1

Operating modes, page 59 an onwards).

The automatic feeder operates in rationed mode by default, but can also be switched to ad lib

mode.
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3.17 Checking and setting the time/date

During the initial startup process, you must check and, if necessary, correct the time and the
date. Time and date are shown in automatic mode (see 4.5.2 Checking and setting the time/

date, page 60).

Note: In order to force an immediate daily offset after changing the date, you have to switch

the feeder off and then on again.

3.18 Drain time station parameters

In the Feed menu, you can define the drain time for each feeding box. The drain time starts
when the rod electrode becomes free for the last portion and ends when the feeding box valve

concerned closes (see 4.5.4 Drain time station parameters, page 64).

If calves do not finish drinking the contents of the mixer jar within the standard setting for drain

time, the drain time can be extended.

3.19 Function keys

The hand terminal has two freely programmable function keys and . You define which
functionality or which menu will be opened when the respective function key is pressed (see

4.5.5 Function keys, page 64).

3.20 Animal list
The animal list is assigned to the key by default (see 4.5.6 Animal list, page 64).

Here is how you define which parameters are displayed in the two columns of the animal list:

1. Choose EDQ > Device data to go to the Animal list submenu.

2. In Column 1 or Column 2, select the parameter by choosing @ or @ You can choose
between Feed consumption in %, Feed consumption in liters, drinking speed in %,

Animal visits and Break offs.

3.21 Checking the components

In the Diagnosis menu you can check alle the components that ahve to be calibrated. This

check is necessary to carry out calibration.
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3.22 Calibrating feed components

You must calibrate the feed components first so that they are mixed in the right proportion (see

8.5 Diagnosis on page 125).

3.22.1 Manually calibrating liquid and powder components

If your automatic feeder does not have an automatic calibration scale, you must provide the

following items for the calibration:

e 1 graduated cylinder with gradations in ml (approximately 1 liter capacity).
® 1 scale (weighing accuracy of 1 g).

® 1 container to collect milk substitute.

3.22.1.1 Calibrating without a calibration scale

You determine the actual value using a scale and a graduated cylinder and the program will

prompt you to enter this value using the number keys.

Proceed as follows to calibrate powder components without a calibration scale:

1. Choose EDQ > Calibration to go to the Components submenu.
2. In the MP menu, you calibrate the milk substitute.
. Confirm MP by choosing .

. Set quantity shows the amount of milk substitute (MP) to be dispensed by the au-

tomatic feeder.
. Runtime shows the time in which the automatic feeder should dispense the MP.
. Date shows when MP was last calibrated.
. Tilt the empty mixer forward.
. Hold the container for the MP under the powder discharge.
. Confirm Start? by choosing .

. Confirm Exit automatic mode? by choosing \T‘ This message will only be dis-

played if your automatic feeder is still in automatic mode.

Powder will be dispensed.
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. Place the container with the collected MP on the scale.
. In the Actual menu, enter the weight displayed on the scale.

. Confirm Confirm value.... by choosing .

. Date now shows the current date.
. Repeat the calibration to check your results.
. Calibrate other powder components using the same method.

Proceed as follows to calibrate liquid components without a calibration scale:

1.

2.

Choose > Calibration to go to the Components submenu.
In the Water menu, you calibrate water.

. Confirm Water by choosing \ﬂ‘

. Set quantity shows the amount of water that the automatic feeder should dispen-
se.

. Runtime shows the time in which the automatic feeder should dispense the water.

. Date shows when the water was last calibrated.

. Confirm Start? by choosing @

. Confirm Exit automatic mode? by choosing w This message will only be dis-

played if your automatic feeder is still in automatic mode.
Water will be dispensed into the mixer.

. Tilt the mixer so that the water flows into the graduated cylinder. Measure the coll-

ected water in milliliters.
. In the Actual menu, enter this measured quantity using the number keys.
. Confirm Confirm value.... by choosing \ﬂ‘
. Date now shows the current date.
. Repeat the calibration to check your results.

. Calibrate other liquid components using the same method.
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3.22.1.2 Calibrating using the calibration scale

The automatic feeder determines the actual value using the built-in automatic calibration scale
(additional equipment). To calibrate the components with the scale, the automatic feeder must

first be calibrated itself in the setup menu (see 5.8 Calibration scale, page 81).

Proceed as follows to calibrate liquid components using the calibration scale:

1. Choose EDQ > Calibration to go to the Components submenu

2. In the Water menu, you calibrate water.

. Set quantity shows the amount of water that the automatic feeder should dispen-
se.
. Runtime shows the time in which the automatic feeder should dispense water.

. Date shows when the water was last calibrated.

. Confirm Start? by choosing . The calibration procedure will start. The set value

of 500 ml will be shown first in the display.

. Confirm Exit automatic mode? by choosing . This message will only be dis-

played if your automatic feeder is still in automatic mode.

The device now performs two check weighings without the user having to do any-

thing and shows the result.

. Then the average value of these two control weighings is shown flashing in the
displayed line. Confirm the Confirm value.... promptby choosing . You then

return to the calibration menu.
. Date now shows the current date.
. Repeat the calibration to check your results.
3. Calibrate other liquid components using the same method.

Proceed as follows to calibrate powder components using the calibration scale:

1. Choose EDQ > Calibration to go to the Components submenu.

2. In MP, you calibrate the milk substitute.

. Confirm MP by choosing .
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. Set quantity shows the amount of MP that the automatic feeder should dispense.
. Runtime shows the time in which the automatic feeder should dispense the MP.
. Date shows when MP was last calibrated.

. Confirm Start? by choosing @

. Confirm Exit automatic mode? by choosing \T‘ This message will only be dis-

played if your automatic feeder is still in automatic mode.

. Place the calibration box into the mixer jar and confirm the prompt Calibration box

used? by choosing F™".

The device now performs two check weighings without the user having to do any-

thing and shows the result.

. Then the average value of these two control weighings is shown flashing in the
displayed line. Confirm the Confirm value.... prompt by choosing . You then

return to the calibration menu.

. Date now shows the current date.
. Remove the calibration beaker from the mixer jar.
. Repeat the calibration to check your results.

. Calibrate other powder components using the same method.

Proceed as follows to calibrate the detergent using the calibration scale:

1.

2.

Choose EDQ > Calibration to go to the Components submenu.
In the Detergent menu, you calibrate the cleaning agent.
. Confirm Detergent by choosing .

. Set quantity shows the amount of cleaning agent that the automatic feeder should

dispense.

. Runtime shows the time in which the automatic feeder should dispense the

cleaning agent.
. Date shows when the cleaning agent was last calibrated.

. Confirm Start? by choosing @
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Confirm Exit automatic mode? by choosing . This message will only be dis-

played if your automatic feeder is still in automatic mode.

Place the calibration box into the mixer jar and confirm the prompt Calibration box

used? by choosing .

Detergent will be dispensed into the calibration beaker.

The device now performs two check weighings without the user having to do any-

thing and shows the result.

Then the average value of these two control weighings is shown flashing in the

nter

displayed line. Confirm the Confirm value.... prompt by choosing ¥ You then

return to the calibration menu.
Date now shows the current date.
Remove the calibration beaker from the mixer jar.

Repeat the calibration to check your results.

3.22.2 Automatic calibration

If the automatic feeder has a calibration scale, it should be used to perform a daily automatic
calibration during normal operation of the feed components to be dispensed. If the calibration
value determined during the automatic calibration deviates from the entered tolerance value,
then the calibration value already determined remains valid. A Calibrating warning will then

be issued.

You set the start of calibration as follows:

1. Choose EDQ > Calibration > Settings to go to the MP or water submenu.

2. In the Calibr./day menu, enter the required number of calibrations per day (MP) or, in the
Autocalib. menu, select yes (water).
Note: If the value O is set in the Calibr./day menu, then the automatic calibration is deacti-

vated.

. Under Calibration times, define the times at which the calibration procedures are to take
place.
Note: Calibration of MP will take place from the set time. First however, a calf must feed

starting at the set calibration time so that calibration can be started.
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4. Enter the required percentage in the Tolerance menu option.

Calibration procedures/day |Water |Milk powder
Default value: Yes 1

Amount changeable: no yes

Range of values: yes/no |0to4

Note: The automatic feeder has a water meter that compensates for water pressure fluctu-
ations. For this reason, the automatic calibration procedure for water is only used as a
check and not as automatic adjustment. If the deviation of the newly determined value ex-

ceeds the tolerance value, then the Calibration warning will be issued.

3.23 Checking or setting cleaning settings

Check the settings for temperature of the cleaning water, detergent amount and teat cleaning
and, if necessary, set them. (see the Cleaning > Settings chapter in the operator's manual for

the automatic feeder).

3.24 Cleaning the automatic feeder

For hygienic reasons, you must completely remove any coolant and lubricant remnants from
the system before commissioning. To do this, execute the cleaning cycle. (see the Cleaning

> Cleaning cycle chapter in the operating manual for the automatic feeder).

Beware of chemical burns from cleaning agents. The cleaning agent can cause
chemical burns to your eyes or hands. Always wear goggles and chemical-proof protective
gloves when using cleaning agents. Follow all the safety instructions listed in the safety data

sheet for the cleaning agent and wear the specified safety equipment.

3.25 Reading in and creating transmitters

During the initial startup process for the automatic feeder, the transmitters have to be read and
created once in the system. When you do this, each transmitter number is assigned one ani-
mal number of no more than six digits. These animal numbers are then available and can be
used to register the animals (see 6 Transmitter and animal management, page 87 and the fol-

lowing pages).
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3.26 Registering animals

Animals will only be fed at the feeder if they are also registered for that feeder (see 6.2 Regis-

tering animals, page 92 and the following pages).

3.27 Entering correction days

During commissioning, the total feeding duration of an animal can be reduced by “shifting” the
animal to the desired plan day. (see the Operation > Feeding chapter in the operating manual

for the automatic feeder).
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4 Programming and control

You control the automatic feeder using the hand terminal. The hand terminal is directly con-
nected to the automatic feeder by a cable. You switch it on and off together with the automatic

feeder. It remains in operation as long as the automatic feeder is switched on.

Note: After the hand terminal has been switched on, the version of the hand terminal's pro-
gram first briefly appears in the display, before the automatic feeder carries out a test routine.

Do not press any buttons on the control panel during these initial routines.

® You monitor and control the automatic feeder (the feeding pump, for example) directly via
the keys of the hand terminal.

® You monitor and change the settings of the automatic feeder and the values of calves via
menus. The menus and sub-menus are arranged so that you can find the necessary set-
tings quickly and easily. With a click of a button, you can access the most important menus,

such as Animal control, Main menu and Manual functions as well as the Animal list.
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4.1 Hand terminal

4.1.1 The 15-key hand terminal

www foerster-technik de

1 Keypad
2 Auto LED
3 Display
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Keypad

With this key, you open the Animal control menu or enter the number 1.

With this key, you open the Main menu or enter the number 2.

With this key, you open the manual functions menu and enter the number 3.

With this key, you open the Search functions or enter the number 4.

With this key, you open the animal list and enter the number 5.

This key is a freely selectable function key. With this key, you can also enter the

number 6.

With this key, you activate the feeding pump or enter the number 7.

This key is assigned 2 functions:

SN N

® You press this key to select a calf in submenus in which an animal number is dis-
played. An asterisk (*) is displayed in front of the animal number of a selected calf.

You deselect the calf by pressing this key again.

® In the overview menu in automatic mode, you use this key to toggle between the

four-line (large font) and the eight-line (small font) display.

With this key, you can also enter the number 8.

j This key is assigned 2 functions depending on the menu you are currently in:

® You use this key to delete warnings and alarms.

® In the overview menu of automatic mode, you use this key to bring warnings to

the foreground.

With this key, you can enter the number 9.
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4.1.2

4.2

You use this key to go backward within the menu structure. You return to the starting

ESC | menu by pressing this key multiple times.

You use this key to move the cursor upward and choose items from a list, for example

ﬂ [yes] or [no]. With this key, you can enter the number O.

With this key you move the cursor downward and select items form a list. You use this

ﬂ key to change the sign of a number, for example from +1 to -1. This is how you enter

negative numbers.

You use this key to confirm your selection and open a menu or an input field. An [input

Enter | field] is indicated by square brackets.

You use this key to scroll between pages on the screen or list items to the left and

< jump to the start of a list.

You use this key to scroll between pages on the screen to the right and jump to the
> end of a list.

Auto LED

The Auto LED (light-emitting diode) of the hand terminal displays important information about

the status of the automatic feeder.

® |n automatic mode, the LED lights up green.
e |n offline mode, the LED is not lit up.

e |f a malfunction occurs, the LED flashes.

You can run the automatic feeder in offline mode or in automatic mode.

Offline mode

In offline mode, you perform actions that you cannot do while the unit is in operation, such as
the recalibration of feed components. When the automatic feeder switches from automatic to

offline mode, the Auto LED goes out.

You switch to offline mode when you open a menu that requires offline mode, such as the cal-

ibration menu.

You switch from automatic mode to offline mode as follows:

1. In the corresponding menu, press .
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2. Confirm the message Exit automatic mode? by choosing @

The Auto LED on your hand terminal goes out.

3. Perform the desired action.

4.3 Automatic mode

You perform most routine tasks, such as feeding, in automatic mode. In automatic mode, the

Auto LED lights up green.

After a prolonged period of inactivity, the automatic feeder automatically returns to automatic
mode. This time period is defined during commissioning (see 3.14 Setting offline mode,

page 39). The default setting is 20 minutes.

You switch from offline mode to automatic mode as follows:

1. Press ®° until the message Start automatic mode? appears in your display.

nter

2. Press B

You are now in automatic mode again. The Auto LED lights up green.

4.4 Menu structure

The automatic feeder is controlled using menus, submenus and lists. You control the auto-
matic feeder by switching to lists via menus and submenus. In these lists, you can view and

change values. The menu structure makes it easier to find a list quickly.

The menus that you require most frequently, such as Animal control E, Main menu @

and Manual functions @ can be directly accessed with the press of button.

The animal list is the list that end users require most often. The animal list can be directly
accessed by pressing the key. You can change this default setting during commissioning
to meet the needs of the end user. The user will then access the animal list via the Animal

control menu.

During commissioning of the automatic feeder, you can assign the key in accordance with

the needs of the end user (see 4.5.5 Function keys, page 64).

If you do not see all the menus or submenus presented here, this is either because the auto-
matic feeder is not equipped with the component in question, or the component was not acti-

vated during setup.
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Note: If you know that the automatic feeder has a component that is not being displayed,
check the setup (see 5 Setup, page 73).
441 Symbols
Symbols are displayed in front of and in several menus, submenus and lists.
4.4.1.1 Arrows
In automatic mode, arrow heads are shown in front of menus:
e P A solid arrow head indicates that the menu contains submenus.
e [> An empty arrow head means that you can change settings here or start actions.
4.4.1.2 Angle brackets
< > If angle brackets are displayed around a menu or list, it means that you can scroll left to
right in order to select menu options or list items. For example, you can select the appropriate
calf from a list of animal numbers using the calf's animal number.
4.4.1.3 Square brackets
[ ] Values or terms are in square brackets. When you press ’;‘ the value / list item begins to
flash in the input field. You can now use the number keys to enter values or use @ |_Tm| to
select values from a list, such as [yes] or [no].
Note: If you enter a value in an input field and the value is too high or too low, this value will
automatically be set to the highest (too high) or lowest (too low) possible value after you press
4.4.1.4 Rod electrode free/covered
In automatic mode, these symbols are displayed at the top right of the display.
H This symbol indicates that the mixer jar is full. The tip of the rod electrode is in the liquid.
E This symbol indicates that the mixer jar is empty. The rod electrode is free of the liquid.
4.4.1.5 Animal identification and feed consumption

The antenna symbol after a station number, such as TR 1 for feeding box 1, indicates that

a calf has been identified at this station.
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4.4.1.6

4.4.1.7

4.4.1.8

4.4.1.9

v'A check mark after the antenna symbol means that calf identified at this station may con-

sume feed here.

Q A lock symbol after the antenna symbol means that calf identified at this station may not
consume feed here. For example, this could be because the concentration of feed in the mixer

jar does not match the feed settings for the identified calf.
- A hyphen after the station number indicates that no calf was identified at this station.

Plan tendency

The arrow to the right next to the animal number indicates the feeding phase the selected calf

iS now in.

7 The feed quantity increases continuously, for example at the beginning of the feeding plan.
-The feed quantity remains constant, for example in the middle of the feeding plan.

N The feed quantity is continuously reduced, for example at the end of the feeding plan.

f The calf is in the 40FIT period.

Marking

* Marked calves are indicated by an asterisk to the left of the animal number.

Alarms

I An exclamation mark to the left of the animal number indicates that a calf has triggered an
alarm.

CalfCloud

C This symbol is displayed in the first line of automatic mode if a connection to the CalfCloud

exists.

4.4.1.10 Sleep mode

4.4.2

The Forster-Technik logo shows you that no key has been pressed on the hand terminal for

an extended period of time. The hand terminal is in sleep mode.

Navigation

You use the hand terminal's keys to navigate through menus, submenus and lists.
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By choosing @ . you can:
® Move between the different submenus of a menu.
® Navigate between the items of a list, for example between [yes] and [no].
By choosing , you can:
e Scroll through a list, for example through animal numbers. At the end of the list, the mes-
sage "end of the list" will appear in the display.
® \When you enter numbers, switch between whole numbers, for example from 1 to 2 to 3.
® Jump to the last menu item.
With "¢ you can:
® Confirm an entry.
® Acknowledge a prompt or message shown on the display.
® Confirm a selection.
® Open menus and submenus.
® Open input fields, which are indicated by square brackets.
e Switch from the number before the decimal place to the number after the decimal place in
input fields.
with ®° you can:
® Go back one menu, each time you press the key. You return to the starting menu by press-
ing this key multiple times.
e Exit the input field or return, without saving, to the number before the decimal place in an
input field.
443 Menus
4.4.3.1 Animal control

You can choose Mto open the Animal control menu. This menu contains all submenus that
the end user requires for daily calf monitoring. The numbers next to the submenus indicate the

number of calves recorded in the submenu concerned.
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4.4.3.2

Animal list. You will see a table that shows the calves, sorted by different parameters, such

as visits to the feeding box.

Entitlement. A list of calves is displayed, sorted by feed entitlement.

Alarm. You will see a list of the calves that have triggered an alarm.

Plan over date. You will see a list of the calves that have a "plan over" date.
Additive (optional) You will see a list of the calves which receive an additive.
40FIT. You will see a list of the calves which are currently in the 40FIT period.
CalfRail (optional). A list of calves that are fed on the CalfRail is displayed.
Marked. You will see a list of calves that have been marked.

New. Here you can view animals that were newly registered in the last 2 days.

Double. Here you assign a new animal number to calves that have been assigned a double

animal number.

Unknown. Here you check whether and when the automatic feeder recorded unknown an-

imal numbers. Here you can correctly register calves that have been recorded in this way.
All. You will see a list of all calves.

Total consumption. Several lists are displayed with the consumption amounts of all calves,

individual calves and individual groups.

Print. Here you can print out the alarm list and the feed list.

Main menu

You can choose to open the main menu. This menu contains all submenus that the end

user requires for daily operation of the automatic feeder.

Animal management
Feeding

Calibration

Device data

Cleaning
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® Diagnosis

4.4.3.3 Manual functions

You can choose to open manual functions. Here you can start certain functions of the auto-
matic feeder manually. For example, you can manually empty the mixer or dispense extra por-

tions.

If you press m, the automatic feeder switches from automatic to manual mode. The LED

extinguishes and the automatic feeder is in offline mode.

Esc

You can actively switch the automatic feeder back to automatic mode. Press until the mes-

nter

sage Start automatic mode? appears in the display. Confirm the message by choosing a

The automatic feeder will return to automatic mode. The Auto LED lights up green.
You can control the following functions manually:

® Extra portion. Here you can dispense extra portions with or without additives.
® Mixer: empty?. The mixer is drained via the mixer drain valve.

® Boiler water: start?. Here you add water from the boiler to the mixer.

® Powder: start? You start dispensing powder here.

® Additive 1 start? (optional). This is where you start dispensingadditive 1.

® Additive 2 start? (optional). This is where you the start dispensing additive 2.
® Mixer: start?. You start the mixer here.

® Feeding box. You open the feeding box valve(s) here.

e Boiler: fill?. You automatically fill the boiler with water here.

® Hoses: open?. Here you can open several valves simultaneously in order to completely

drain all the lines of the automatic feeder of water.

45 Device data

The following submenus can be found under Device data:
® QOperating modes

® Portion



Programming and control 59

45.1

4511

® Date/time

® Stations

® Function keys
® Animal list

® Data backup

® New installation

e Cloud

Operating modes

In the Operating modes menu, you set the operating modes of the feeder.

Rationed mode / ad lib mode

The automatic feeder operates in rationed mode by default, but can also be switched to ad lib

mode.

® Inrationed mode, the feeder uses animal identification, i.e., the animals are individually

fed rationed amounts. Rationed mode is the default setting.

® The feeder does not use animal identification in ad lib mode. The automatic reading in of
transmitter numbers is therefore not possible in this operating mode. During feeder opera-
tion, a portion is always prepared as soon as the rod electrode in the mixer jar is free (mixer
empty). The feeding box valves are constantly open.
Beware of the risk of burns on feeding box valves. During prolonged ad lib
mode, feeding box valves become hot. You, or the end user, can burn your fingers or hand
when touching these valves. For this reason, push the suction hose directly onto the mixer

jar spout and disconnect the connector from the feeding box valve.
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1 Female power connector

2 Box valve

Cleaning agent that enters the feed can be hazardous to the health of calves.
Therefore, always disable all time-controlled cleaning menus and calibrations during ad lib

mode.

You set the operating mode as follows:

1. Choose EDQ > Device data > Operating modes to go to the Ad lib submenu.

2. Select the option yes in the selection box to activate the ad lib mode. Choose no to select

rationed mode.

3. Inthe subsequent lines, if necessary, adjust the values for the feed concentration and the

additive dosage.
Note: These settings are used during the preparation of all feed portions.

4,5.2 Checking and setting the time/date

During commissioning, you have to check and, if necessary, correct the time and the date.

Time and date are shown in automatic mode.

Set the time of day, date and date format as follows:

1. Choose EDQ > Device data to go to the Time/date submenu.

2. In Time, you enter the current time of day.

w

. In Date, you enter the current date.

IN

. In Format, you choose the desired date format.
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4.5.3

4531

Note: In order to force an immediate daily offset after changing the date, you have to switch

the feeder off and then on again.

Setting the portion

The automatic feeder and preparation of the feed are designed so that even a milk substitute

with a higher fat melting point can be easily processed.

Feed temperatures that are too low can cause digestion problems in calves and
feed temperatures that are too high can cause gastritis in the abomasum. The temperature of
the feed in the mixer jar must correspond to the mixing temperature specified by the MP man-

ufacturer. Keep to the feed temperatures recommended in this operating manual.
In this menu, you make the following settings for the feed portion:

® Set the set temperature of the feed in the mixer jar.

e Set the minimum temperature of the water in the boiler.

® Set a pause between the dispensing of two portions.

® Set the parameters for the mixer’s draining, emptying and for its OFF delay.

Setting the set and minimum temperature

Note: The first portion of feed, depending on the ambient temperature, is always mixed some-

what warmer.

Set the set temperature and the minimum temperature as follows:

1. Choose > Device data > Portion to go to the Set temp. or Min. temp. submenu.

2. Enter the desired set temperature in Set temp. of the feed in the mixer jar (= mixing tem-

perature).

3. Enter the desired minimum temperature in Min. temp. for the water in the boiler.

Enter 0°C in Min. temp. in order to disable the minimum temperature parameter.

4. After entering the temperature, check whether the portion is being prepared with the set

temperature.

Set temperature |Minimum temperature

Default value: 42 °C 39°C

Permitted range of values: |10 °C to 44 °C 0 °C to set temperature minus 0.5 °C
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45.3.2

Note: The values that you have entered for set and minimum temperature will be converted to
the set and minimum temperature of the boiler water. If the temperature of the boiler water falls
below the minimum temperature, the feed preparation will be interrupted until the minimum

temperature has been reached again.

Dispensing pause

To lengthen the time to prepare the feed, a dispensing pause can be set. As the preparation
of a portion starts, the feed station valves will close and stay closed until the dispensing pause

is over.

We recommend entering a dispensing pause for:
e milk substitutes with poor solubility,

® very high concentrations (> 200 g/l),

® extreme calf drinking speeds (> 2 I/min).

You set the dispensing pause as follows:

45.3.3

1. Via > Device data > Portion go to the Dispensing pause submenu.

2. In Dispensing pause enter the required value in seconds, from 1-16. The default value is 0.

Mixer draining

Leftover feed in the mixer must be evacuated. This is done either via the mixer drain valve or

the teat. Alternatively, you can choose not to evacuate residual amounts at all.

Leftover feed in the mixer can lead to an increased risk of infection when outdoor
temperatures are high (summer). When outdoor temperatures are low (winter), leftover feed
in the mixer becomes so cold that calves will no longer drink it. This can lead to malnutrition.
Malnutrition can cause impaired growth and development, increased susceptibility to illness or

even death of the calves.

Leftover feed in the mixer jar provides a perfect breeding ground for germs. You specify the
amount of time after which this leftover feed is discarded in order to ensure optimal feed
hygiene. Mixer draining may also be followed by a drainage procedure (see the Cleaning

chapter in the operator's manual for the automatic feeder).
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4.5.3.3.1 Mixer draining via mixer drain valve

The best and simplest solution is to evacuate the contents of the mixer via the mixer drain
valve. You specify whether a mixer drain valve is present during setup (see 5.5.1 Mixer drain,

page 78).
Note: The mixer drain valve is included by default.

Proceed as follows to specify the amount of time after which a remaining portion in the mixer

will be evacuated
1. Choose ~& > Device data > Portion to go to the Draining submenu.

2. In Draining, enter the desired period in minutes.

Default value: 15 min
Permitted range of values: 0 min (= draining deactivated),
5to 120 min

4.5.3.3.2 Mixer draining via teat

Leftover feed can also be evacuated via the teat using the feeding pump. Alternatively, you

can choose not to evacuate residual amounts at all.

Note: This function only appears if the mixer drain valve is deactivated during setup.

You set mixer drainage via the teat as follows:

45.3.4

1. Choose > Device data > Portion to go to the Drain via teat submenu.
2. In the Drain via teat menu option, specify whether the mixer is to be drained.

Mixer OFF delay

You can change the runtime of the mixer in the OFF delay menu option. Whether and how

long the mixer should have an OFF delay depends on the solubility of the milk substitute.
1. Choose EDQ > Device data > Portion to go to the Mixer OFF delay submenu.

2. In Mixer OFF delay, enter the desired value.

Default value: 3 sec

Permitted range of values: |0to 12 sec
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454 Drain time station parameters

In the Feed menu, you can define the drain time for each feed station. The drain time starts
when the rod electrode becomes free for the last portion and ends when the feed station valve

concerned closes.

If calves do not finish drinking the contents the mixer jar within the standard setting for drain

time, the drain time can be extended.

You can extend the drain time as follows:

1. Choose EDQ > Device data > Boxes > Feed to go to the Drink-out time submenu.

2. In Drink-out time, you enter the desired time.

Default value: 16 sec
Permitted range of values: | 10 to 60 sec

45,5 Function keys

The hand terminal has two freely programmable function keys and . You define which

functionality or which menu will be called up when the respective function key is pressed.

You define the function keys as follows:

1. Choose > Device data to go to the Animal list submenu.
2. Choose or to go to the desired function, for example Start mixer.

3. Choose to confirm.

4. Choose or to select the symbol of the function key to which the assignment is to be

made.
. The list symbol stands for the key.

Note: This key is assigned the animal list by default.
. The hash symbol stands for the key.

. The hyphen [-] in the selection box is used to remove an assignment.

45.6 Animal list

In the animal list menu, you can list the calves in a table sorted by parameters. The table is

sorted in ascending order by the first column of the first parameter. Parameters sorted in
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ascending order. This means that the calf with the greatest need for monitoring is at the very

top of the table. The following parameters can be displayed:

® Feed consumption as a percentage

® Feed consumption in liters

® Animal visits

Breaks

Drinking speed as a percentage

column 1 column 2

vy

P 799 A2 |29 | 56 |V
744 fAl |29 | v |v+
715 —A1 |50 |91 |91

81 |v

795 —D2 vV

1/118 | cons. |dr.

737 7Al | v | 56 |v+|

| v
743 Al | v |B5 |V+]
| v

sp
v+
v
91

T4
v

v
v

Note: You can also access the animal listdirectly via the key.

Here is how you define which parameters are displayed in the two columns of the animal list:

1. Choose > Device data to go to the Animal list submenu.

2. In Column 1 or Column 2, choose Em to select the parameter to be displayed in the

respective column.

You call up an animal list as follows:

1. Choose M to go to the Animal list submenu.

2. Inthe top line, from left to right, you can check the following:

4

TR

B 799 wAZ? |29 | 56 |v

1/118 cons. dr.sp

v+
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. The number of the calf you have selected in the list, counting from the top (1).
. How many calves are registered (2).
. The two parameters you have chosen (3 & 4).

3. You can view the following in the subsequent lines, from left to right:

1/118 cons. dr.sp
P 799 NA2? |29 |56 |v | v+
AAA LA
12 345 6 7 8

. The animal number (1).

. The plan tendency (2).

. The group to which the calf concerned has been assigned (3).
. The last feeding box visited (4).

. Parameter 1. The current value (today) is in the column on the left (5). Yesterday's

value is in the column on the right (6).

Note: The parameter for feed consumption is simply today's value (consumption

until present time) in liters with two decimal places.

. Parameter 2. The current value (today) is in the column on the left (7). Yesterday's

value is in the column on the right (8).

Note: If there is a check mark instead of a number, then the value is 100%. A
check mark followed by a plus indicates a value greater than 100% (only for

drinking speed and visits).

Example: The calf shown with the number 799
1/118 cons. dr.sp

B 799 wa? |29 | 56 |v | ¥+ | isinthe weaning phase (reduced plan

tendency), has been assigned to group A and

has visited feeding box 2. At present, the calf has only called up 29 % of its feed
entitlement, yesterday it was only 56 %. The current value for drinking speed is
100% (¥); yesterday it was more than 100% (v +).

4. By choosing , you can go to the detailed view for the currently marked animal. By choos-

ing < m you can scroll to the other animals.
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1< 3469>a1 -7 6.0 1
P cons. %: 25 100
break off: 1 0
speed. %: 85 100
visit: 3 6
e R 99 100
weight kg: 117 11e6
W. gain: 600 400
feed. day: 77

Note: In each line, by pressing ﬂ detailed information can be called up.

4.5.7 Backing up and restoring data

Every day at midnight, a backup of animal data and device data is performed automatically

so that a current backup of data is available in case of data loss.

Data can be lost when the program version of the automatic feeder is updated.
You must also save the data of the automatic feeder manually, for example to an SD card. Oth-
erwise, calves may suffer from malnutrition if incorrect feed portions are dispensed. Malnutri-
tion can cause impaired growth and development, increased susceptibility to illness or even

the death of your calves.

4.5.7.1 Internal data backup (automatic feeder)

4.5.7.1.1 Saving data

You save data as follows:

1. Choose > Device data > Data backup to go to the Internal (feeder) submenu.

2. Confirm Save? by choosing .
A progress bar informs you about the current status of the data backup being carried out.
4.5.7.1.2 Restoring data
You restore data as follows:

1. Choose EDQ > Device data > Data backup to go to the Internal (feeder) submenu.

nter

2. Confirm restore?F

nte|

3. Confirm the security prompt restore last backup? by choosing M

A progress bar informs you about the current status of the backup being carried out.
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4.5.7.1.3 Checking the current data backup

Check the data backup as follows:

45.7.2

1. Choose EDQ > Device data > Data backup to go to the Internal (feeder) submenu.

2. In the last backup menu, you can view the time and date of the last backup performed.

External data backup using an SD card

During each backup, a folder with the date of the backup is created on the SD card. In the case
of arecovery, a date stored on the SD card can be entered and selected using the number

field. The date of the last backup is always shown on the display.

SD card and hand terminal

Proceed as follows to perform a data backup using an SD card:

1. Open the rubber cover on the right side of your hand terminal.
2. Insert the SD card into its slot.

3. Choose EDQ > Device data > Data backup to go to the SD card menu.

nter

4. Confirm save? with E

A progress bar informs you about the current status of the data backup being carried out.

This is how to perform a backup:

1. Choose > Device data > Data backup to go to the SD card menu.

2. Confirm restore? by choosing @ in order to perform a backup.

2.1 Ifrequired, in the Date menu, enter a date, from which you would like to restore

nter

the data, and confirm this with E
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3. In the Date menu, you can see when the last data backup was performed.
4. Remove the SD card.

5. Close the rubber cover.

45.7.3 Cloud

In this menu, you can back up data to the cloud.

Perform a backup as follows:

1. Choose > Device data > Data backup to go to the Cloud menu.

2. Confirm save? by choosing \T‘

A progress bar informs you about the current status of the data backup being carried out.

This is how to perform a backup:

4.5.8

1. Choose EDQ > Device data > Data backup to go to the Cloud menu.
2. Confirm restore? by choosing ’; in order to perform a backup.

2.1 If required, in the Date menu, enter a date, from which you would like to restore

the data, and confirm this with E"".
3. In the Date menu, you can see when the last data backup was performed.

New installation

The program (software) must be completely reinstalled (reset) when commissioning or recom-
missioning the automatic feeder. This will remove superfluous data as well as outdated or

incorrect settings from the memory.

Note:New installation will result in the deletion of the animal data. The transmitter numbers

will be set to zero and the Device data will be overwritten with default values.

Animal data is, for example, group membership, barn transfer date, feeding days, consump-

tion totals.

Device data includes portion settings, for example.

4.5.8.1 Only reinstall device data, plans, animal data or transmitter numbers

Proceed as follows to reinstall device data, plans, animal data and transmitter numbers:

1. Choose > Device data to go to the New installation submenu.
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2. Confirm Device data by choosing @
3. Confirm Reinstall device data? by choosing ’;

4. Confirm the security prompt Do you really want to restore the data to factory settings?

by choosing ™.

The message New installation completed! will appear.

5. Confirm New installation completed! by choosing =™".

You are back in the New installation menu.
6. Perform steps 2 to 5 in the same manner for plans, animal data or transmitters.

4.5.8.2 Reconfiguring everything

You can also reconfigure all menus instead of individual menus.

Reconfigure all menus as follows:

1. Choose > Device data to go to the New installation submenu.
2. Confirm Everything by choosing @
3. Confirm Reinstall everything? by choosing \T‘

4. Confirm the security prompt Do you really want to restore the data to factory settings?
by choosing .

The message New installation completed! will appear.

5. Confirm New installation completed! by choosing E™®'.

All data has been reset to factory settings.

Note: The settings in the feeder setup are not changed by new installation .

459 CalfCloud

In this menu you can find the CalfCloud settings.
1. Move via EDQ > Device data to the submenu Cloud.

. In start? you can establish the connection between the Cloud and the automatic

feeder.

. Press "', The fault menu last error will appear. The following error messages

can be displayed:
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 none. There is no error..

* no eth. cable. No Ethernet cable is connected. If necessary, contact your ser-

vice technician.

* nointernet. There is no Internet connection. If necessary, contact your service

technician.

» connect.error. Connection fault to the server. If necessary, contact your ser-

vice technician.

. In terminate? you terminate the connection to the Cloud and thus also the data

transmission.

. Status shows you the current status of the connection to CalfCloud. Online,

offline or reconnecting can be displayed.
. Auth-Token shows you the authentication key of the automatic feeder.

Note: With this token you can add the automatic feeder to the Cloud.

4.6 Software update

To update the application program, depending on the device, you have a choice between an

SD card or FlashManager.

The options available for your equipment can be seen in the dealer area of Forster-Technik's

web site www.foerster-technik.de.
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5 Setup

The program menus in the setup menu contain basic settings, e.g. for the equipment of the

automatic feeder. Check to ensure that the settings are correct.

You open the setup menu as follows:

1. Press EDQ and keep this key pressed when you switch on the feeder.

After a short time, the setup menu will appear in the display.
2. If you want to change settings, go to the relevant menu option and make the changes.
3. Confirm your changes by choosing .

4. To exit the setup, press E until the message Exit setup? appears. Choose to confirm.
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5.1 Overview of the Setup menus

Language German
Time/date Time / date
Type Powder
Number 1-99 (= machine number, decimal)
Address 2-FC (= CAN address, hexadecimal)
System Interval (IV)
Operating mode SA/SM
Machine Base size 500 ml
Heating electronic / none
Boiler valve Brass
Mixer drain present yes
QO Additive dispenser 1 present yes / no?
©Additive dispenser 2 present yes / no?
@ Detergent pump present yes / no?
Equipment @ Detergent sensor no / rod
Circulation valve Valve/ no
QAir valve present yes / no?
Circulation pump present yes / no?
Mix. sensor T. present yes / no?
Water meter yes
Point electrode yes
Identification Type Multi / Tiris / Ned
Squelch 0to 255
ID chip activated yes
read?
activated (yes / no)
@Calibration scale ?:Cgﬁ ?:;tor
Cal. date
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Stations

Feed

<internal 1>, <internal 2>

<IFSfeed1.. 8>

<IFS feed quadruple 1, 2>

CalfRail

© Concentrate

<IFS-C1.. 8>

Allocation: [C-station 1 .. 8]

Address: 51-60

Type: Standard

© Animal scale

Activate

Adjust

Terminal

Address

1-FC (= CAN address, hexadecimal)

Contrast

70%

Sleep mode

0-999 min.

Communication

Institute

yes/ no

© Printer

no / serial / CAN

© Gateway

MAC:

IP: 0-255.0-255.0-255.0-255
SN: 0-255 . 0-255 . 0-255 . 0-255
IP assignment: manual / autom.
Factory settings?

MultiReader

No

Version

update Multireader?
Temperature

Read transponder
-type/-country/-no/
Squelch

Resets

Restarts

CAN analyzer

CAN devices

CAN errors

CAN load

Network configuration

M:

IP: 0-255.0-255.0-255 . 0-255
SN: 0-255 . 0-255 . 0-255 . 0-255
GW: 0-255 . 0-255 . 0-255 . 0-255
IP assignment: DHCP / static
accept?

Cloud

Restart

Restart?

SD card

Feeding plans

Feeding plans read in / active / changed

Licenses

Request license/ Read data/ Active licenses
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Initial operation: Date
last: Date

Type: RS1/RS2/RS3
next: Date

Type: RS1/RS2/RS3
Service done?

Service

5.2 Language

You select the language for the user interface of the feeder as follows:

1. In the setup menu, choose the Language option.
2. Select the desired language for the user interface.

3. Confirm your entry by choosing ﬂ

5.3 Timel/date

You set the time / date as follows:

1. In the setup menu, choose the Time / date option.
2. Enter the current time of day and the current date.

3. Confirm your entries by choosing @

5.4 Machine

5.4.1 Feedertype
There are three different automatic feeder types:
® Powder: feeds MP water mixtures.
® Combi: feeds fresh milk as well as MP water mixtures.

® Milk: feeds fresh milk only.

You select the feeder type as follows:

1. Leave the factory default value as it is.

5.4.2 Feeder number

For the KalbManagerWIN program (optional additional equipment) to access the automatic

feeder's software, the automatic feeder needs a number. Number 1 is set by default.
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Note: When connecting more than one automatic feeder, be sure that each number is only

assigned once.

You select the feeder number as follows:

5.4.3

1. In the setup menu, choose the Machine option.

2. In Number, you select a number.

3. Confirm your entry by choosing @

Feeder address

For clear identification, every participant of the CAN bus system needs an address.

Address ranges for members of CAN networks
1-10 => hand terminal

11-20 | => automatic feeder

21-30 |=> Forefoot weighing machine

41-50 |=> IFS feed single

51-60 |=>IFS-C

61-70 | =>IFS feed quadruple

71-79 |=> CalfRall

You select the feeder address as follows:

5.4.4

5.4.5

1. In the setup menu, choose the Machine option.

2. In Address, you select an address.

3. Confirm your entry by choosing &'

Note: If you select an address that has already been assigned, the message Address already

assigned! will appear in the display.

Feeder operating mode

The automatic feeder can be operated in Stand Alone (SA) mode or System machine (SM)

mode. Please leave the factory set value SA (= Stand Alone) as it is.

Base size

The set value determines:

® The set quantity for calibrating Boiler water.
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® The standard portion size.

You define the size as follows:

5.4.6

1. In the setup menu, choose the Machine option.
2. Under Base size enter 500.
3. Confirm your entry by choosing ﬂ

Heating

Here you specify whether the feeder has a heater and, if so, what type of heating relay it has.

You set the heating type as follows:

54.7

5.5

551

1. In the setup menu, choose the Machine option.
2. In Heating, select electronic.
3. Confirm your entry by choosing E"".

Boiler valve

Please do not change the factory settings.

Equipment

Here you specify whether the automatic feeder is equipped with certain components or
options.
Mixer drain

The contents of the mixer are drained fully automatically via the mixer drain valve. The mixer

drain valve is included by default.

You set the mixer drain valve as follows:

5.5.2

1. In the setup menu, open the Equipment option.
2. In Mixer drain, choose yes if a mixer drain valve is present, otherwise choose no.
3. Confirm your entry by choosing @

Additive dispenser

Up to two additive dispensers can be connected to the automatic feeder.
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You activate the additive dispenser as follows:

5.5.3

1. In the setup menu, open the Equipment option.

2. In Add. disp. 1 select yes if there is an additive dispenser, otherwise choose no.

3. Confirm your entry by choosing J‘

4. In Add. disp. 2 select yes if there is a second additive dispenser, otherwise choose no.

Detergent pump

Detergent is fully automatically dispensed via the detergent pump during a cleaning cycle.

You set the detergent pump as follows:

5.5.4

5.5.5

5.5.6

55.7

1. In the setup menu, open the Equipment option.

2. In the Detergent pump menu, choose yes if there is a detergent pump, otherwise choose

no.

nte

3. Confirm your entry by choosing a

Detergent sensor

If the level in the detergent tank is detected by a float switch mounted on a bearing bar, set
bar. If, however, the detergent sensor is integrated in the detergent’s system of pipes, set no.
Circulation valve

Please do not change the factory setting [no].

1. In the setup menu, open the Equipment option.
2. In Circ. valve, choose nol/.

3. Confirm your entry by choosing @

Air valve

The air valve is part of the compressed air cleaning system.

Mixer temperature sensor

The temperature sensor in the mixer continually records the temperature of the feed in the
mixer jar. If the temperature deviates from the set value, the boiler heater will be adjusted to

compensate. The feed always has the desired temperature, regardless of the season.
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You set the mixer temperature sensor as follows:

1. In the setup menu, open the Equipment option.
2. In Mix. sensor T, choose yes if there is a temperature sensor, otherwise choose no.
3. Confirm your entry by choosing ™.

55.8 Water meter

Please do not change the factory settings [yes].

5.5.9 Supply and point electrode

Specify [yes] for point electrode.

You set the electrode as follows:

1. In the setup menu, open the Equipment option.
2. In the Point electrode menu, menu, select [yes].

3. Confirm your entry by choosing @

5.6 Identification

Type and squelch

Here you set the identification system, depending on the identification system of the distribu-
tion partner. The input or reading sensitivity of the identification system is set via the squelch
value. The larger the entered value, the lower the range of the identification system (see 3.6

Connecting antennas, page 31).

You set the identification system as follows:

1. In the setup menu, open the Identification option.
2. In Type, select the identification system.
3. In Squelch, select the squelch value.

4. Confirm your entry by choosing ﬂ
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5.7 IDchip

Before delivery, all setup settings are saved as read-only settings on the ID chip. This means

you can restore the original settings of the setup at any time. For example, this may be neces-

sary if you have accidentally changed a setting or the processor board has to be replaced.

You set the ID chip as follows:

1.

2.

3.

4.

In the setup menu, choose the ID chip option.

In activated, you must specify yes because the automatic feeder is equipped with an ID
chip.

Confirm read? by choosing @ if you want to transfer the data from the ID chip to the pro-
cessor board.

nter

Confirm your entry by choosing £

5.8 Calibration scale

You activate the calibration scale as follows:

1

2.

In the setup menu, open the Calibration scale option.

In activated choose yes if a calibration scale has been installed.

. Confirm your entry by choosing J‘
. Press adjust? \T‘ to adjust the calibration scale.

. The adjustment process begins with the taring of the calibration scale. You will be informed

of this in the calibration scale will be tared message.

A menu appears where you need to enter the reference weight in grams that you require
for the adjustment. If need be, adapt the respective value in this menu (default value: 500
9).

Note: A 500 g reference weight is included in the delivery.

. Place the reference weight with the hole on the screw in the feeding box such that it is fixed

in place, and then press E"" in order to start the adjustment process.

. After completing the adjustment process, a corresponding message about the success or

lack of success of the adjustment will be issued. At the same time, the currently determined
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weight value will be shown. After removing the calibration weight, 0 grams should be shown

here.

9. Press . Date now shows the current date.

5.9 Stations

Activate the feed or concentrate station and define the additional equipment for these stations
or any additional equipment in the Stations menu. Automatic feeders are normally equipped

with one station valve for one feeding box.

5.9.1 Feed

You set the feeding box as follows:

1. In the setup menu, choose the Stations > Feed > Internal option.
2. In Allocation select the feeding box to be allocated to the internal control system.

3. Confirm your entry by choosing @

5.10 Terminal

5.10.1 Address

The hand terminal is integrated into the CAN bus system of the automatic feeder. That is why

is needs its own address. Address 1 is set by default.
Note: In a CAN bus system, each address may only be assigned once.

You set the address as follows:

1. In the setup menu, choose the Terminal option.
2. In Address, select [1].
3. Confirm your entry by choosing @

5.10.2 Contrast

You set the contrast as follows:

1. In the setup menu, choose the Terminal option.

2. In Contrast, enter the desired value. The default value is 60%.

nter

3. Confirm your entry by choosing a
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5.10.3 Sleep mode

If no key has been pressed on the hand terminal for a longer period of time, it will switch to
sleep mode. If the hand terminal is in sleep mode, the Forster-Technik logo will appear in the

display.

You set sleep mode as follows:

1. In the setup menu, choose the Terminal option.

2. In Sleep mode, enter the required value. The default value is 10 minutes. To deactivate

sleep mode, set [0] minutes.

3. Confirm your entry by choosing ﬂ

5.11 Communication

5.11.1 ©Printer

Current animal lists can be generated via the automatic feeder’s printer function.

® Serial: Select this option if you have connected a commercially available printer via the se-

rial interface to the automatic feeder.

® CAN: Select this option if the printing data is to be sent via the CAN bus. In this case, a PC
program will play the counterpart.

5.11.2 @Gateway

You can configure all relevant parameters of the @Forster gateway here.

® MAC address: You can see the MAC address of your gateway here. Your gateway is
uniquely identified via its MAC address. This address cannot be changed.

® |P address: You can see the IP address of your gateway here and, if need be, change it.
You will need this value to register your feeder at the CalfManagerWIN or in connection with

the communication module.
® Subnet mask: You can see the subnet mask of your gateway here and, if need be, change
it.

® |P assignment: If the value here is automatically set, then your gateway will try to get its
IP address from a DHCP server in your network. If you select manual here, then you will

have to set the IP address of your gateway yourself.
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5.11.3

511.4

5.11.5

DHCP status (only in connection with the automatic assignment of IP addresses): This line
gives you information about the internal status when getting the automatically assigned IP

address. There are five statuses that can occur: OK, waiting, off, on and unknown (=n/a).

Factory settings: If you call up this item and confirm the security query which then ap-
pears, the values of your gateway for the IP address, the subnet mask and the manual or

automatic procurement of the IP address will be reset back to the factory settings.

MultiReader

Here, you can call up information about the connected MultiReader calf identification system.

Version shows the current version of the MultiReader identification system.

In the Update menu, if you press , you can update the MultiReader identification sys-
tem.
Note: To update the MultiReader identification system, you may have to first update the au-

tomatic feeder.

CAN analyzer

Here, you can call up information about the CAN bus. This information can be helpful if a fault

occurs in the CAN bus system.

Network configuration

You can configure all parameters of the network here.

MAC address: You can see the MAC address of your network here. Your network is
uniquely identified via its MAC address. This address cannot be changed.

IP address: You can see the IP address of your network here and, if need be, change it.
Subnet mask: You can see the subnet mask of your network here and, if need be, change
it.

Gateway: You can see the MAC address of your gateway here. Your gateway is uniquely

identified via its MAC address. This address cannot be changed.

IP assignment: If you select DHCP here, the data will be automatically assigned. If you se-

lect static here, you will have to set the IP address of your network yourself.

nter

Accept?: Press ™. The data will be saved.
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5.11.6

5.11.7

Cloud

Here you can set up the values for CalfCloud and the internet connection from the automatic

feeder to the Cloud.
® |n start? you can establish the connection between the Cloud and the automatic feeder.

. Press ™", The fault menu last error will appear. The following error messages can

be displayed:

. none. There is no error.

. no eth. cable. No Ethernet cable is connected.
i no internet. There is no Internet connection.

. connect.error. Connection fault to the server.

® |nterminate? you interrupt the connection to the Cloud and thus also the data transmis-

sion.

® Status shows you the current status of the connection to CalfCloud. Online, offline or re-

connecting can be displayed.

® Auth-Token shows you the authentication key of the automatic feeder.

Note: With this token you can add the automatic feeder to the Cloud.

Restart

You can restart the automatic feeder here.
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6 Transmitter and animal management

6.1

6.1.1

All menus for management of the list of all transmitters and the calves registered at the feeder

can be found via EDQ > Animal management.

Managing transmitters

Basics

6.1.1.1 Identification process at the station

6.1.1.2

1 Antenna

2 Collar transmitter

3 Earmark transmitter

For identification purposes, each calf wears a collar with a transmitter or an earmark with a
transmitter. The transmitter has a multi-digit number, which is also usually stamped into the
transmitter housing. This transmitter number is sent from the transmitter to the antenna,

which is part of the feeding box.

Connection of transmitters and animal numbers

The multi-digit transmitter number is not well suited for the rapid location of individual calves.
For this reason, a calf is issued an animal number along with the transmitter number. The ani-

mal wears this animal number on an easily readable collar, or the animal number is put on the
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6.1.2

6.1.2.1

earmark where it can be easily read. Up to 250 different animal numbers of up to six digits can
be assigned to the calves.
Creating transmitter numbers

When the feeder is commissioned, existing transmitters have to be created once in the system.
When you do this, each transmitter number is assigned one animal number of no more than

six digits. These animal numbers are then available and can be used to register the calves.

Reading transmitter numbers

When creating new transmitter numbers, it is a good idea to have these read by the feeder.

This saves you from typing in the numbers and eliminates the possibility of typing errors.

To set up the reading of transmitter numbers by the feeder, proceed as follows:

6.1.2.2

1. Choose > Animal management > Transmitters to go to the New submenu.

2. Hold a transmitter next to the identification unit of a feeding box.

The number of the transmitter will be read in and displayed in the line after No. t. At the
same time, the animal number to be newly assigned will be suggested in the Animal no.
line.

Note: You can affect the suggested animal number by selecting an assignment scheme for

the animal numbers in the No. line.

3. Check whether the suggested animal number is correct and, in the line accept?, press

Enter_

Note: Make sure that the correct feeding box is selected in Stations.

4. In order to allocate the newly read transmitter number to the displayed animal number, con-
firm the security prompt Create new no. xxx for animal xx? by choosing Enter,
Manually entering transmitter numbers

Instead of reading the transmitters, you can also manually type in the transmitter numbers, if

necessary

You manually enter transmitter numbers as follows:

1. Choose EDQ > Animal management > Transmitters to go to the New submenu.

2. Enter the transmitter number in the No. menu and confirm it by choosing Ener.
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6.1.3

6.1.3.1

3. In the Animal No. menu, check the suggested animal number and confirm it by choosing

Enter

4. Confirm accept? by choosing @

5. In order to allocate the newly read transmitter number to the displayed animal number, con-

firm the security prompt Create new no. xxx for animal xx? by choosing .

Assigning animal numbers

If the transmitter numbers are automatically read when new numbers are created, an animal
number will be automatically suggested. When doing this, there are two schemes to choose

from for the assignment of numbers.

Consecutive assighment of animal numbers

There is a counter which counts up for each new transmitter number as it is read. In this way,
all of the transmitter numbers that are registered by the identification function are linked to con-

secutive animal numbers; e.g., from 1 to 50.

You set up consecutive assignment of animal numbers as follows:

6.1.3.2

1. Choose EDQ > Animal management > Transmitters to go to the New submenu.
2. Select the consecutive option in No.

3. If necessary, in next, specify the animal number at which you want automatic reading of

transmitters to start.

Note: If you use collars, it makes sense to start with 1 and read in the transmitters in order.

Assignment of animal numbers based on transmitter numbers

More and more often, calves are already equipped with an electronic earmark transmitter
when they are born and keep this earmark their whole lives. The automatic feeder program
has been adapted for this type of transmitter so that the registration process of the transmitters

and calves can take place completely automatically.

You set up automatic assignment of animal numbers as follows:

1. Choose > Animal management > Transmitters to go to the New submenu.

2. Select the automatic option in No.
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3. Inthe Range menu, define the part of the transmitter number that you would like to use as

the animal number. The animal number can have a maximum of six digits.

For example: 5-2 means that, counting from the right, the second to the fifth digits of the
transmitter number will be used as the animal number. 6-1 means that, counting from the

right, the first to the sixth digits of the transmitter number will be used as the animal number.

6.1.4  Editing transmitter or animal numbers

If necessary, (e.g., if a transmitter is lost), a transmitter number can be subsequently changed

or deleted.

6.1.4.1 Changing the transmitter number
Manually changing the transmitter number

You manually change a transmitter number as follows:

1. Choose EDQ > Animal management > Transmitters to go to the Edit submenu.
2. Select the transmitter number to be changed.

3. Change the transmitter number in the No. menu and confirm by choosing \T‘

Reading the new transmitter number for the change

You read a new transmitter number as follows:

1. Choose EDQ > Animal management > Transmitters to go to the Edit submenu.
2. Select the transmitter number to be changed.

3. Confirm read? by choosing J‘

A new menu is displayed, and the transmitter number flashes in the first line.

4. Hold the transmitter that you want to read next to the identification unit.

The number is automatically accepted in the first line.
5. Confirm accept? by choosing .

6.1.5 Changing the animal number
Like the transmitter number, the animal number can also be changed.

1. Choose > Animal management > Transmitters to go to the Edit submenu.

2. Select the animal number you would like to change.
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3. Inthe Animal No. menu, change the animal number that is currently allocated to the trans-

mitter and confirm by choosing Enter,

6.1.5.1 Deleting transmitter numbers

You delete transmitter numbers as follows:

6.1.6

6.1.7

1. Choose > Animal management > Transmitters to go to the Edit submenu.

2. Select the transmitter number to be deleted and confirm Delete by choosing .

Note: You can only delete transmitter numbers of calves that are not registered (= status:
available).
Deleting the transmitter number when canceling an animal's registration

Generally, the collars (or earmarks) with the respective transmitters remain at the organization
and are reused after the calf is taken out of the pen and its registration is canceled. For this

reason, the default setting when canceling the registration of a calf is to not delete its transmit-
ter number. If the calf's transmitter is, however, not reused but rather stays with the calf, (life-

long earmark), make the following setting in the feeder:
1. Choose EDQ > Animal management > Cancel to go to the Settings submenu.

2. Select the yes option in Delete no. When a calf's registration is canceled, the transmitter
number is also deleted along with the animal number. This prevents an accumulation of un-

used transmitter numbers, which would use up the available storage space.
Retrieving transmitter statistics
You retrieve a transmitter statistic as follows:
1. Choose EDQ > Animal management > Transmitters to go to the Information submenu.

2. An overview of the transmitters created in the system is displayed. The following is shown
in the displayed list:

. In the Registered menu, you check the number of registered transmitters or cal-
ves.
. In the Available menu, you check the number of available transmitters.

. In the Free menu, you check how many transmitters you can still create.
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6.2

6.2.1

Registering animals

Calves are only fed at the feeder if they are also registered there. You can either manually reg-
ister each calf or instruct the feeder to automatically register the calves. In the latter case, the
calf is registered as soon as it enters the feeding station for the first time. This means that the

manual registering of the calves is not needed.

During registration, the calf is allocated to one of four groups, A to D. The calf will then be fed

in accordance with the feed and concentration plans of this group.

The group to which you allocate the calves depends solely on the feed quantity, concentration
that the end user wants to feed the calves. In this case, it does not matter which station the

calves consume their feed in or which bay the calves have been housed in.

Registering animals manually

You register animals manually as follows:

6.2.2

1. Choose EDQ > Animal management > Register to go to the Animal submenu.
2. Select one of the available (not yet registered) animal numbers.
3. In Group, select the group to which the calf is to be allocated.

4. If you want to reduce the total feeding duration for the calf, you can set this up underCor-

rection days (see Feeding> Total feeding duration in the operator's manual).
5. Confirm Register? by choosing ™.
6. Confirm the prompt Register animal xx in group X? by choosing @

Note: On its registration day, the animal receives the exact amount of feed, spread over the
course of the day, as intended for the first day according to the feeding plan. If you have
entered correction days, the animal will receive the feed that is intended for the corresponding

day.

Note: For the next manual registration, the values last set will again be shown and can be used
or changed for the current animal.

Registering animals automatically

If an animal that is not yet registered enters the feeding station for the first time, it can then be

automatically registered. For automatic registration, three different modes can be set which
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6.2.2.1

are described in detail in the following three sub-sections. The following table presents an

overview of this.

Overview of the three modes for automatic registration

Automatic registra- Transmitter number being identified

tion mode available unknown

deactivated Warning Unknown trans- | Warning Unknown transmitters

mitters

available transmitters | Animal will be registered Warning Unknown transmitters

all transmitters Animal will be registered Transmitter is created, new animal
number is assigned, animal is regis-
tered

Deactivating automatic registration

Automatic registration is deactivated by default. You can restore this setting at any time:

You deactivate automatic registration as follows:

6.2.2.2

1. Choose EDQ > Animal management > Register to go to the Automatic submenu.

2. Select Mode no and confirm by choosing \ﬂ Automatic registration is then deactivated.

Note: When the registration function is deactivated, the unknown transmitters warning

will be triggered if an unregistered calf enters a station.

Only automatically register available transmitters

Automatic registration shortens the registration process for the calves. When doing this, you
can specify that only calves can be registered whose transmitter numbers are already in the
system. If an available transmitter number is registered in the identification unit, the corre-

sponding calf will be automatically registered. Calves or transmitter numbers that have not yet

been created in the system will trigger the Unknown transmitter number warning.

Proceed as follows to set up automatic registration of available transmitters:

1. Choose EDQ > Animal management > Register to go to the Automatic submenu.
2. In Mode select the available option.

3. In Group, choose the group in which you want to automatically register the calves.
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Note: The registration of calves that are to be removed should only be canceled after they
have left the bay, as they will otherwise automatically be reregistered when they enter the sta-
tion and will then be returned to the start of the feeding plan.

6.2.2.3 Creating transmitter numbers and automatically registering calves

To shorten the registration process even more, you can specify that calves can also be regis-
tered if their transmitter numbers are not known in the system. This eliminates the need for
reading or manual entry of transmitter numbers. In this case, if an unknown transmitter number
is registered in the identification unit, this transmitter number is automatically created in the

system and a new animal number is issued and registered at the same time.

Note: When newly creating transmitters and animal numbers, the animal number will either be
produced consecutively or as a part of the transmitter number (see 6.1.3 Assigning animal
numbers, page 89). Clarify whether this kind of number assignment is actually what the end

users wants.

Proceed as follows to create transmitter numbers and automatically register calves:

6.3

6.3.1

1. Choose EDQ > Animal management > Register to go to the Automatic submenu.
2. In Mode select the All option.
3. In Group, choose the group in which you want to automatically register the calves.

Note: Calves without collars should never be in the bay. They could push other animals out

of the way and steal remaining amounts of feed.

Canceling animals or animal groups

Individual calves or a group of calves that are no longer being fed according to the plan must
be removed from the pen compartment and their registration canceled. The same applies to

calves whose feeding plan has expired.

Canceling an individual animal's registration

You cancel an individual animal's registration as follows:

1. Choose > Animal management > Cancel to go to the Animal submenu.
2. Select the desired animal number.

3. In the Plan end menu, you check how much longer the calf is to be fed according to the

plan.
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4.

. Confirm cancel? by choosing ©

In the MP menu, you can check how much milk powder the calf has consumed from the

start of registration to its cancellation.

nter

in order cancel a calf.

There is a risk of malnutrition if calves do not receive any feed. Malnutrition can
cause impaired growth and development, increased susceptibility to iliness or even death
of the calves. Inform the end user that he/she must provide the canceled calves with feed
using an alternative method.

Note: If you have chosen the value All or Available for the automatic registration mode,
the end user should remove unregistered calves from the bay, because otherwise they will

be automatically registered again.

6.3.2 Canceling a group registration

You can cancel a group registration as follows:

1.

2.

6.

Choose > Animal management > Cancel to go to the Group submenu.
Select the required group.

In Registered, you can see how many calves are being fed according to the corresponding

plan.

. In Weaned you can see how many calves have finished the feeding plan and are therefore

no longer receiving any feed.

Confirm Cancel? with @ if all calves of the group are to be canceled regardless of wheth-

er they are registered or weaned calves.

nter

Confirm the security prompt Cancel animals in group? by choosing E

6.3.3 Canceling the registration of weaned animals

You can cancel the registration of weaned calves as follows:

1. Choose ED’! > Animal management > Cancel to go to the Weaned animals submenu.

2. Confirm Cancel? by choosing ™ if you want to cancel weaned calves.

3. Confirm the security prompt Cancel animals? by choosing ’;‘

6.4 Transferring animal registrations

You can transfer calves registered at an automatic feeder to another group at any time.
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To transfer a registered calf to another group, proceed as follows:

1. Choose > Animal management to go to the Transfer submenu.
2. Select the desired calf.
3. Select the desired feeding group in Group.

4. Confirm the prompt Register animal xx in group X? by choosing @

Note: When registration is transferred, the feeding day is retained; the calf will not be reset
to the start of the feeding plan (= to plan day 1).
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7 Shutting down and recommissioning the automatic feeder

This chapter explains how to shut down the automatic feeder temporarily or permanently and

recommission it.

7.1 Shutdown

You can shut down the automatic feeder temporarily or permanently.

To make the procedure easier and ensure that you do not miss any steps, see the check list
Shutting down the automatic feeder in the appendix (see chapter 9.3 Automatic feeder shut-

down checklist, page 140).

7.1.1 Temporary shutdown

You can temporarily shut down the automatic feeder, for example from the end of one calving

season to the start of the next.

If you are shutting down the automatic feeder for a prolonged period of more than one year,

you should store the feeder in an upright position in a clean, dry and frost-free location.
In addition, observe the following rules when transporting the automatic feeder:

o Health hazards caused by lifting heavy loads. Do not move the automatic

feeder by yourself.
® The automatic feeder must always be transported in an upright position.

To ensure that the automatic feeder does not become a breeding ground for germs, which
could endanger the health and life of the calves when you recommission the feeder, you must

thoroughly clean the automatic feeder before shutting it down.

Depending on how the automatic feeder is configured, you must run the manual or automatic

cleaning programs for the mixer, heat exchanger, hoses, teat and powder container.

After cleaning, you must disconnect the power and water supplyboilerseal the cable glands for
antennas and the Ethernet connection with dummy plugs and drain the water from the mag-

netic valves and the volume control valve.

To shut down the automatic feeder, proceed as follows:

Beware of Chemical burns from cleaning agents. The cleaning agent can cause

chemical burns to your eyes or hands. Always wear goggles and chemical-proof protective
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gloves when disposing of cleaning agents. Follow all the safety instructions listed in the safety

data sheet for the cleaning agent and wear the specified safety equipment.

1. Start the maximum number of cleaning programs (see Cleaning chapter in the operating

manual for the automatic feeder).

2. Drain the water from the boiler, solenoid valves and the pressure-reducing valve to prevent

the automatic feeder from being damaged by frost.

Beware of damage to the automatic feeder. Frozen water expands and can

damage automatic feeder components that contain water, such as the solenoid valves.
2.1 Close the water tap that supplies water to the automatic feeder.

2.2 De-pressurize the hoses by dispensing water into the mixer jar.

2.3 Press m.

2.4 Confirm Bo. water start? by choosing .

Beware of lethal electric shock. The electrical components of the automatic
feeder are live. Before continuing, always turn off the automatic feeder using the main switch

and disconnect the power plug.
3. Turn off the automatic feeder with the main switch and disconnect the power plug.
3.1 Disconnect the water hose between the solenoid valve for water and the boiler .

3.2 Open the vent screw on the cover of the boiler. As soon as air flows in, the water

will drain.
3.3 Let the water drain completely.
3.4 Reattach the water hose and tighten the vent screw.

4. Disconnect the water hose from the water tap that supplies the automatic feeder with water

and from the water connector on the automatic feeder.

5. Dispose of the water hose.

Beware of the risk of infection. To prevent infections, use a new hose when re-

commissioning the unit.
6. Pour the liquid from the mixer into a container or the drain.

7. Remove the teat from the feeding box.
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8. Dispose of the teat.

Beware of the risk of infection. To avoid infections, use a new teat when recom-

missioning the unit.
9. Disconnect the hose from the teat to the feeding box valve or the mixer jar.

10.Dispose of the hose.

Beware of the risk of infection. To prevent infections, use a new hose when re-

commissioning the unit.
11.Disconnect the hose that runs from the drain channel to the mixer drain valve.

12.Dispose of the hose.

Beware of the risk of infection. To prevent infections, use a new hose when re-

commissioning the unit.

13.Seal the cable gland of the Ethernet connection with a dummy plug and close the antenna

connections using the locks.

Moisture can enter the control box through the cable glands of the Ethernet

connection and damage it.

14.Clean the outside of the automatic feeder using a damp cloth. Clean all areas that are not

reached by the cleaning program.

High-pressure sprays can damage the automatic feeder. Only clean the auto-

matic feeder by hand using a damp cloth.
15.Empty the powder container.

16.Remove the screws holding the safety grid on the powder container. Remove the safety

grid.

17.Empty the detergent tank (optional).
Beware of Chemical burns from cleaning agents. The cleaning agent can
cause chemical burns to your eyes or hands. Always wear goggles and chemical-proof pro-
tective gloves when disposing of cleaning agents. Follow all the safety instructions listed in

the safety data sheet for the cleaning agent and wear the specified safety equipment.

18.Clean the powder container and dosing unit (see Cleaning chapter in the operating manual

for the automatic feeder). To do this, use the scraper supplied.

19.Cover the automatic feeder with a tarpaulin. This will protect it from dirt.
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7.1.2

7.2

7.2.1

Permanent shutdown

If you are going to permanently shut down the automatic feeder, you must dispose of it in
accordance with the law. To find out which regulations apply to you, contact your waste dis-

posal company or a waste disposal center listed in the yellow pages.

In the appendix of this manual, you will find a list of the materials used in the construction of

the automatic feeder (see chapter 9.2 Automatic feeder material list, page 139).

® Perform steps 2 to 18 of the shutdown (see chapter 7.1.1 Temporary shutdown, page 97).

You do not have to perform step 1, cleaning.

® Dispose of any residual cleaning agent. See the data sheet of the cleaning agent for infor-
mation on the disposal of the cleaning agent.
Beware of Chemical burns from cleaning agents. The cleaning agent can
cause chemical burns to your eyes or hands. Always wear goggles and chemical-proof pro-
tective gloves when disposing of cleaning agents. Follow all the safety instructions listed in

the safety data sheet for the cleaning agent and wear the specified safety equipment.

® Dispose of the automatic feeder as described in the disposal chapter in the operating man-

ual for the automatic feeder.

Recommissioning

Recommissioning after temporary shutdown without change of location

In the following description, we are assuming that you have only disconnected your automatic

feeder from the water and power supply.

You can reconnect these lines yourself. To make the procedure easier and ensure that you do
not miss any steps, see the check list for recommissioning the automatic feeder (see chapter

9.1 Checklist for commissioning and recommissioning, page 133) in the appendix.

Proceed as follows to recommission the automatic feeder:

1. Remove the cover.
2. Clean the outside of the automatic feeder with a damp cloth.

3. Install the safety grid for the powder hopper attachment. Screw the screws back into the
holes provided. The safety grid for the powder hopper attachment prevents you from being

injured by the rotating tools in the powder hopper, for example, when adding milk powder.
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4. Connect the water connector of the automatic feeder to the water tank using a clean new

water hose.
5. Put the detergent supply into operation again.

6. Connect the teat to the feeding box valve (rationed mode) or the mixer jar (ad lib mode).

Use a new hose for this connection.

The hose must be installed at a gradient to the automatic feeder without sag-

ging. This makes it easier for calves to consume feed and makes it easier to drain the hose

ﬂ

(see the illustration).

w

50-80 cm

N

Hose with gradient between teat and feeding box valve

7. Connect the mixer drain valve to the drain channel. Use a new hose for this connection.
8. Remove the dummy plugs for the Ethernet Cable and replace them with a grommet.

9. Remove the locks on the antenna connections and connect them to the antennas.
10.Plug the power plug into the power outlet.

11. Switch on the automatic feeder using the main switch.

Fault, Boiler not filled appears in the display of the hand terminal.

12.Press .

13.Confirm Boiler: Fill? by choosing ﬂ
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7.2.2

7.2.3

The boiler is automatically filled with water.
14.Choose EDQ > Device data to go to the Time or Date submenu.
. In the Time menu, you enter the time of day using the number keys.
. In the Date menu, you enter the time of day using the number keys.
. In the Format menu, you use ﬁ b to select the desired date format.

15.Start the maximum number of cleaning programs (see Cleaning chapter in the operating

manual for the automatic feeder).
Clean the hoses and the powder container.

By doing this, you prevent germs that enter the automatic feeder from multiplying and in-

fecting your calves.

16.Fill the powder container with milk substitute (MP). Use only milk substitute that is suitable
for feeding calves.

Make sure that no paper or other foreign bodies enter the powder container.

This could damage the dosing mechanism or impair dosing accuracy.
17.Calibrate all feed components (see 3.22 Calibrating feed components, page 42).
18.Check the setup settings (see 5 Setup, page 73).

Recommissioning after long-term shutdown or change of location

If your automatic feeder has been shut down for an extended period or moved to another loca-
tion, you can recommission it as follows (see 3 Commissioning, page 27).
Recommissioning after processor card replacement

After a shutdown, for example after replacing the processor board, you must set up the device

data again.

Proceed as follows:

1. Switch on the automatic feeder using the main switch.

2. Confirm the message first startup press enter to start installation by choosing ™.

The message restore last backup? will appear if there is a valid backup of the animal and

device data in the automatic feeder.

3. Confirm restore last backup? by choosing .



Shutting down and recommissioning the automatic feeder 103

The animal data and device data from the last backup will be restored.

Note: If no data is present, follow the same steps as in commissioning (see 3 Commission-

ing, page 27).

. Inthe Basic settings menu, enter the desired language, the current date and the current

time of day.

This concludes the recommissioning process.
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8 Faults and warnings

The automatic feeder shows fault messages or warning messages in the display to indicate

faults during feeder operation.
In the event of a fault, automatic mode is interrupted and no feed is prepared.

An interruption in feeding operation means that your calves will not receive any
feed. This can lead to malnutrition. Malnutrition can cause impaired growth and development,
increased susceptibility to illness or even death of the calves. Inform the end user that he/she

must provide the calves with feed using an alternative method if feed operation is interrupted.

In the case of a warning, automatic mode will not be interrupted and feeder operation will con-

tinue.

Once you have eliminated the fault, delete the fault and warning messages.
® Some fault and warning messages are deleted automatically.

® Some fault and warning messages can be deleted by pressing .

® Some fault and warning messages are deleted by confirming Delete fault? or Delete warn-

Enter

ing? by choosing

8.1 Faults

8.1.1 Calibration scale

If the calibration scale was not adjusted during setup, you will see Fault, calibration scale in

the display.

You correct the fault as follows:

1. Confirm Calibration scale with Enter,
2. Press adjust? 5™ to adjust the calibration scale.

3. The adjustment process begins with the taring of the calibration scale. You will be informed

of this in the calibration scale will be tared message.

4. A menu appears where you need to enter the reference weight in grams that you require
for the adjustment. If necessary, adapt the respective value in this menu (default value: 500
9).

Note: A 500 g reference weight is included in the delivery.
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8.1.2

5. Place the reference weight with the hole on the screw in the feeding box such that it is fixed

in place, and then press E"" in order to start the adjustment process.

6. After completing the adjustment process, a corresponding message about the success or
lack of success of the adjustment will be issued. At the same time, the currently determined
weight value will be shown. After removing the calibration weight, 0 grams should be shown

here.

7. Press . Date now shows the current date.

Heating

Fault heating xx.x °C will be shown in the display if the temperature of the boiler water is too
low. Feeder operation will be interrupted until the set minimum temperature has been reached.
Make sure that the end user provides the calves with feed using an alternative method as long

as feed operation is interrupted.

You correct the fault as follows:

8.1.3

If heating up the boiler water does not solve the problem:

1. Choose EDQ > Device data > Portion to go to the Set temp. or Min. temp. submenu and

check the temperature settings.

2. Check that the heater is working properly.

Temperature too high

Fault, temperature too high will appear in the display when the water temperature in the
boiler is too high. Feeder operation will be interrupted until the water in the boiler has cooled
to the set maximum temperature. Make sure that the end user provides the calves with feed

using an alternative method as long as feed operation is interrupted.

You correct the fault as follows:

1. Confirm Fault, temperature too high by choosing ﬂ
2. In Boiler water start?, press & hold @
3. Drain water from the boiler into the mixer jar until the fault message disappears.

4. Confirm Mixer: empty? by choosing .

Check the temperature of the supplied water if the Boiler is supplied with preheated water.
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8.1.4

Boiler not filled

When you turn on the automatic feeder, the control unit checks whether the boiler is filled with
water. If it is not filled, feeder operation will be interrupted and the message Fault, Boiler not

filled will appear in the display.

Feeder operation will be interrupted. Make sure that the end user provides the calves with feed

using an alternative method as long as feed operation is interrupted.

You correct the fault as follows:

8.1.5

1. Confirm Fault, boiler not filled by choosing @

2. Check the water supply

3. In the Fill Boiler menu, press ﬂ

4. Check whether the water jet hits the rod electrode and the display shows covered.

5. Check that the shutoff valves and the drain valve are not leaking.

Note: If liquid in the mixer is flowing out through these valves, the rod electrode cannot be

grounded (see 8.1.5 Water shortage, page 107).
If the fault persists, proceed as specified in “Water shortage”, page 107.

Water shortage

Feeder operation will be interrupted. Make sure that the end user provides the calves with feed

using an alternative method as long as feed operation is interrupted.

You correct the fault as follows:

1. Confirm Fault, water shortage by choosing @

2. Confirm Boiler water start? by choosing \T‘

3. Check the water supply to the automatic feeder.

4. Check whether deposits such as calcium have formed on the electrodes.
5. Confirm Delete fault? with if you have fixed the fault.

Lethal electric shock. The electrical components of the automatic feeder are live.
Always turn off the automatic feeder using the main switch and disconnect the power plug

before you change the response sensitivity of the electrode.
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Check and change the response sensitivity of the electrode.
1. In the right-hand column, check the status (free or covered).
1.1 In Status, check the status (free or covered).
1.2 Confirm Boiler water, start? by choosing .
The electrode will be triggered if water is dispensed into the mixer jar.
1.3 Confirm Mixer: empty? by choosing @ to pump out the liquid again.
2. Visually inspect the electrode.

2.1 Ifthe electrode reports that it is covered although it is actually free, the sensitivity

of the electrode is too high.

2.2 Reduce the sensitivity of the electrode by rotating the potentiometer (see machine

circuit diagram in the appendix) counterclockwise on the main board.

2.3 If the electrode reports that it is free although it is actually covered, the sensitivity

of the electrode is too low.

2.4 Increase the sensitivity of the electrode by rotating the potentiometer (see machine

circuit diagram in the appendix) clockwise on the main board.
3. Confirm Delete fault? with if you have fixed the fault.

8.1.6 Water meter

Fault, water meter will appear in the display if the rod electrode is grounded when water is

dispensed, but the water meter issues no pulse.
Feeder operation can be continued in emergency mode.

You start emergency mode as follows:

1. Confirm Fault, water meter by choosing \T‘

2. Confirm Bo. water start? by choosing @

w

. Check whether pulses are shown in the display.
4. Confirm Mixer emptying? by choosing .

. Confirm Delete fault? by choosing w

ol
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6. Confirm emergency mode start? by choosing \ﬂ

Warning, water meter will appear in the display. The calibration values for the water boiler

become invalid.

7. Calibrate the boiler water.

The automatic feeder will operate in emergency mode, the error message Calibr. Bo. wa-

ter will disappear.

You correct the fault as follows:

8.1.7

Repair or replace the water meter if necessary.

1. Delete the water meter warning.

You will see the fault message Calibr. Bo. water will appear in the display.
2. Calibrate water.
3. Return to automatic mode.
Mixer emptying
Fault, mixer emptying will appear if the mixer cannot be drained.

Feeder operation will be interrupted. Make sure that the end user provides the calves with feed

using an alternative method as long as feed operation is interrupted.

You correct the fault as follows:

Lethal electric shock. The electrical components of the automatic feeder are live.
Always turn off the automatic feeder using the main switch and disconnect the power plug

before you perform work on the feeder's components.
1. Turn off the automatic feeder using the main switch and disconnect the power plug.

2. Check all components carrying feed from the mixer to the mixer drain valve or from the mix-

er up to the teat for blockages and remove them.
3. Insert the power plug and turn on the automatic feeder again using the main switch.
4. In Mixer emptying?, confirm by choosing Enter,

5. Check the feeding pump:

Enter

5.1 Confirm Start feeding pump? by choosing
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6. Check the mixer drain valve:
6.1 Confirm Open mixer drain? by choosing @
7. Check the rod electrode:
7.1 Confirm Bo. water start? by choosing to fill the mixer with water.
8. In Mixer emptying?, confirm by choosing ’;
9. Confirm delete fault? by choosing @ if you have fixed the fault.

10.Remove detergent remnants from components carrying feed by rinsing them with water.

Detergent remnants that enter the feed can be hazardous to the health of

calves. Remove detergent remnants before recommissioning the automatic feeder.
11.Return to automatic mode.
8.1.8  Heating
Fault, heating will be shown in the display if the heater is faulty.

Feeder operation will be interrupted. Make sure that the end user provides the calves with feed

using an alternative method as long as feed operation is interrupted.

You correct the fault as follows:

Lethal electric shock. The electrical components of the automatic feeder are live.
Before working on components, always turn off the automatic feeder using the main switch and

disconnect the power plug.
® Check whether safety temperature limiter has been triggered.

® Check the temperature sensor.

If the temperature sensor is defective, replace it.

® Check whether voltage is applied to the heater. If necessary, check the fuses provided by

the customer (solid state relay).

® Check the heating rod for continuity.

If the heating rod is defective, replace it.
® Check the setup settings for the heating system.

. Setup > Machine > Heating: electronic
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You reactivate the safety temperature limiter as follows:

Lethal electric shock. The electrical components of the automatic feeder are live.

Always turn off the automatic feeder using the main switch and disconnect the power plug

before you reactivate the safety temperature limiter.

1.

2.

Confirm Delete fault? with if you have fixed the fault.

Turn off the automatic feeder using the main switch and disconnect the power plug.

. Open the right side door of the automatic feeder.

. Remove the metal cover under which the safety temperature limiter is located.
. Press the reset button in order to reset the safety temperature limiter.

. Reattach the metal cover.

. Close the side door.

. Insert the power plug again and turn on the automatic feeder again using the main switch.

8.1.9 Boiler temperature sensor

Fault, Temp. sensor, boiler is shown in the display if the temperature sensor of the boiler is

defective.

Feeder operation will be interrupted. Make sure that the end user provides the calves with feed

using an alternative method as long as feed operation is interrupted.

You correct the fault as follows:

Beware of lethal electric shock. The electrical components of the automatic

feeder are live. Always turn off the automatic feeder using the main switch and disconnect the

mains plug before you work on the main board.

1.

2.

Turn off the automatic feeder with the main switch and disconnect the mains plug.

Remove the metal cover on the back of the automatic feeder.

. Measure the resistance of the temperature sensor on the main board.

. Compare the measured value with the value in the table. The table can be found in the ma-

chine circuit diagram in the appendix.
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5. If the measured value differs from the value in the table, you must replace the sensor. (see
machine circuit diagram in the appendix).
6. Reattach the metal cover.
7. Insert the mains plug again and turn on the automatic feeder again using the main switch.
8.1.10 Calibration

Fault, calibration will be shown in the display if the liquid or powder feed components and the

detergent have not been calibrated.

Feeder operation will be interrupted. Make sure that the end user provides the calves with feed

using an alternative method as long as feed operation is interrupted.

You correct the fault as follows:

8.1.11

1. Calibrate all components shown in the display (see 3.22 Calibrating feed components,

page 42).

ID chip

The automatic feeder is equipped with an electronic name plate (ID chip) upon which the
device number and other important information for the operation of the automatic feeder is

stored.

Failure, ID chip missing is shown in the display if the ID chip is defective. For the first 30 days
after the fault appears, feeder operation will continue normally. After this, the automatic feeder

will not be fully functional.

Make sure that the end user provides the calves with feed using an alternative method as long

as feed operation is interrupted.

You replace the ID chip as follows:

1. Order the new ID chip, specifying the device number.

Beware of lethal electric shock. The electrical components of the automatic
feeder are live. Always turn off the automatic feeder using the main switch and disconnect

the mains plug before you work on the main board.
2. Turn off the automatic feeder using the main switch and disconnect the mains plug.

3. Open the flap on the back of the automatic feeder.
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4. Disconnect the old ID chip from the main board (see circuit diagram provided).

5. Insert the ID chip on the main board.

6. Close the flap on the back of the automatic feeder.

7. Insert the mains plug and turn on the automatic feeder again using the main switch.

8. Choose Setup > ID chip to go to the Read submenu.

9. Activate the ID chip by choosing @

8.1.12 Box/drain valve

Fault, Box/drain valve is shown in the display if a feeding box valve or the mixer drain valve

is leaking. The automatic feeder loses water during cleaning.

Feeder operation will be interrupted. Make sure that the end user provides the calves with feed

using an alternative method as long as feed operation is interrupted.

You correct the fault as follows:

1. Check all feeding box valves and the mixer drain valve for leaks.

11

1.2

Clean leaky valves in order to remove any foreign objects that might have entered

the system.

Repair leaky valves or replace them.

2. Check the rod electrode.

2.1

2.2

2.3

2.4

2.5

Choose EDQ > Diagnosis > Sensors to go to the El. rod submenu.
In the right-hand column, check the status (free or covered).
Confirm El. rod by choosing .

In Status, check the status (free or covered).

Confirm Boiler water start? by choosing @

The electrode must report that it is covered if water is dispensed into the mixer jar

up to the electrode.

If the rod electrode reports that it is free, you must readjust it (see 8.1.6 Water me-

ter, page 108).
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If the fault persists, you must replace the rod electrode.

3. Confirm Delete fault by choosing once you have eliminated the fault.

8.1.13 Uncontrolled output

The automatic feeder monitors all outputs during current operation which are responsible for
the dispensing of water, milk powder, additives and detergent, as well as the mixer drain valve.
If the corresponding relays are actuated for more than 60 seconds, the fault Uncontroll.

output will appear in the display. Depending on the type of defect, one of the following fault

codes will be displayed:

® Boiler water, if the boiler water valve is faulty.

® Mixer drain, if the mixer drain valve is faulty.

® Powder, if the motor of the milk powder conveyor is defective.
® Additive dispenser, if the additive dispenser is defective.

Feeder operation will be interrupted. Make sure that the end user provides the calves with feed

using an alternative method as long as feed operation is interrupted.

You correct the fault as follows:
® Check the water valve of the boiler.
1 Choose EDQ > Diagnosis to go to the Valves submenu.

2 Confirm Bo. water open? by choosing @ to open the water valve. The valve re-

mains open as long as you hold down @
3 Check whether the valve opens. The valve opens when the water is dispensed.

4 If a valve is defective, repair or replace it.

® Check the mixer drain valve.
agnos
1 Choose ~a& > Diagnosis to go to the Valves submenu.

2 Confirm Mixer drain open? by choosing ’;‘ to open the mixer drain valve. The valve

remains open as long as you hold down .
3 Check whether the valve opens. The valve opens when the water drains.

4 If a valve is defective, repair or replace it.

® Check the motor of the milk powder conveyor.

1 Choose EDQ > Diaghosis to go to the Motors submenu.
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2 Confirm Powder start? by choosing \ﬂ‘ in order to start the motor of the powder con-

veyor.
3 If the motor does not start, check the plug on the powder conveyor or check the power

supply.

® Check the additive dispenser.
1 Choose EDQ > Diagnosis > Motors to go to the Additive submenu.
2 Confirm Start? with @ to start the additive conveyor motor.

3 If the motor does not start, check the plug or the power supply.

8.2 Warnings

8.2.1 Mixer emptying

Mixer emptying warning appears if the mixer cannot be drained. For example, this can be

because the drain is clogged or the feeding pump is no longer running.

Lethal electric shock. The electrical components of the automatic feeder are live.
Before working on components, always turn off the automatic feeder with the main switch and

disconnect the power plug.

You rectify the warning as follows:

1. Check all components carrying feed from the mixer to the mixer drain valve or from the mix-

er up to the teat for clogs and remove them.

The hose which goes from the mixer drain valve to the drain channel must not

be lengthened.
2. Check the feeding pump.
2.1 Confirm Mixer emptying warning by choosing ’;
2.2 Confirm Feeding pump: start? by choosing @
The feeding pump will be actuated.
3. Check the mixer drain valve.
3.1 Confirm the Mixer emptying warning by choosing @
3.2 Confirm Mixer drain: open? by choosing J‘

The mixer will be drained.
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4. Check the rod electrode.
4.1 Visually check the rod electrode for deposits.
4.2 Check that the rod electrode works properly (see 8.5.3 Checking sensors,
page 126).
5. Fill and drain the mixer.
5.1 Confirm Boiler water, start? by choosing W
The mixer will fill up with water.
5.2 Confirm Mixer: empty? by choosing @
The mixer will be drained.
If the fault has been fixed, confirm the message Delete warning? in the display with @
8.2.2  Mixer temperature sensor

The Mixer temp. sensor warning will be shown in the display if the temperature sensor in the

mixer jar is faulty or the temperature of the mixed feed in the mixer jar drops below 0 °C.

You rectify the warning as follows:

8.2.3

Use a ohmmeter to measure the voltage at the input of the temperature sensor on the board.
Compare the measured value with the value in the circuit diagram, and if it is different, replace
the temperature sensor (see circuit diagram provided).

Identification

Warning, identification appears in the display if animal identification is not working.

You eliminate the warning as follows:

8.2.4

Check the cables leading to the antenna. Repair any damage or replace the cables or anten-

nas.

Incorrect ID

All CAN nodes have a unique ID which cannot be changed. The ID is used to automatically
check whether the right node reports on the CAN address. If this is not the case, it is possible
for the feeder and the node to communicate, but there will be no proper data exchange. Warn-

ing, Incorrect ID appears in the display.
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You eliminate the warning as follows:

8.2.5

Check all CAN addresses.

Switch on the feeder and hold down the EDQ button until the setup menu appears in the dis-

play.

. Go to Setup > Boxes and check the CAN addresses of the individual CAN nodes.

. To exit the setup, press % until the message Exit setup? appears. Confirm this by choos-

: Enter

ing

If IDs have changed, e.g., for reasons of compatibility, you must update all CAN nodes. To do

this, use an SD card or FlashManagerPlus.

Address used twice

If two or more nodes are linked together in a bus system, it can happen that one CAN address

is issued twice. Warning, address used twice appears in the display.

You rectify the warning as follows:

8.2.6

1.

nte

Confirm Warning, Address used twice by choosing M
The CAN node with the double address will be displayed.

. Choose Setup > Boxes to open the submenu shown in the display with the double ad-

dress.

. Assign another address which is still available to the CAN node with the double address.

For more information on assigning CAN addresses, see the Setup > Address chapter (see
5.4.3 Feeder address, page 77).
Note: If possible, use an address from the standard range of numbers for the CAN node

concerned.

. Confirm your changes by choosing .

. To exit the setup, press % until the message Exit setup? appears. Confirm this by choos-

: Enter

ing

. Delete the warning on all feeders.

Unknown transmitters

The Unknown transmitters warning appears in your display:
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e |f a transmitter is detected by the identification unit for which no animal number has been

assigned.

e |f a transmitter number has been allocated to an animal number, but has still not been reg-

istered.

You rectify the warning as follows:

8.2.7

1. Confirm Unknown transmitters warning by choosing J‘

2. In No., you check the unknown transmitter number.

3. In Number, you check how often the unknown transmitter number has been identified.
4. In Time, you check when the transmitter was last registered by the identification system.
5. Confirm delete? by choosing @ if you want to delete the transmitter number.

6. Confirm Register by choosing E"" if you want to allocate the unknown transmitter number
to an animal number.
Calibration

The calibration warning will appear in your display if the last calibration was 120 days ago or

if automatic calibration failed. You will see which components you have to calibrate.

You rectify the warning as follows:

8.2.8

1. Calibrate all components shown in the display (see 3.22 Calibrating feed components,

page 42).
2. Confirm delete warning? by choosing ﬂ

Note: If you delete the warning without calibrating, the message will appear again the next

day.

Calibration scale

The calibration scale warning will appear in your display if your calibration scale is not work-
ing.

There is a risk of malnutrition caused by incorrectly dispensed feed portions. Mal-
nutrition can cause impaired growth and development, increased susceptibility to illness or

even death of the calves. You must ensure that the end user provides his/her calves with feed

using an alternative method as long as the calibration scale is not working.
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You rectify the warning as follows:

8.2.9

Lethal electric shock. The electrical components of the automatic feeder are live.
Before working on components, always turn off the automatic feeder using the main switch and

disconnect the power plug.

1. Check whether the circuit board for the mixer scale is correctly plugged onto the main board

of the feeder.

2. Check the cables which go to the calibration board as well as to the load rod for visible dam-

age (for example, animal bites).
3. Check the load rod and the calibration unit of the mixer scale.

Note: The warning is automatically deleted when the fault has been rectified.

ID chip

The automatic feeder is equipped with an electronic name plate (ID chip) upon which the
device number and other important information for the operation of the automatic feeder is

stored.

The warning ID chip still xx days will appear in your display if the ID chip is defective. After

30 days, the functionality of the feeder will be limited.

An interruption in feeding operation means that your calves will not receive any
feed. This can lead to malnutrition. Malnutrition can cause impaired growth and development,
increased susceptibility to illness or even the death of your calves. Make sure that the end user
provides the calves with feed using an alternative method as long as feeder operation is inter-

rupted.

You replace the ID chip as follows:

1. Order the new ID chip, specifying the device number.

Beware of lethal electric shock. The electrical components of the automatic
feeder are live. Always turn off the automatic feeder using the main switch and disconnect

the mains plug before you work on the main board.
2. Turn off the automatic feeder using the main switch and disconnect the mains plug.
3. Open the flap on the back of the automatic feeder.

4. Unplug the old ID chip from the main board (see circuit diagram provided).
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5. Insert the new ID chip on the main board (see circuit diagram provided).

6. Close the flap on the back of the automatic feeder.

7. Insert the mains plug and turn on the automatic feeder again using the main switch.
8. Choose Setup > ID chip to go to the Read submenu.

9. Activate the ID chip by choosing J‘

8.2.10 Double animal number

Warning, double animal no. will appear in your display if the same number was assigned

twice during the fully automated registration process.

You change the double animal number as follows:
1. Confirm Double animal no. warning with Enter

The Double menu in animal control appears (see the Animal control > Double chapter

in the operator's manual).
2. In No., the full transmitter number of the animal appears.
3. In Animal no., change the automatically assigned number.
4. In Time and Date, check when the double animal number appeared.
5. Once you have changed the animal number, confirm confirm? by choosing B,

Note: Only when you have changed the animal number will your confirmation take effect and

the warning be deleted.

8.2.11 Machine capacity

Warning, Machine capacity will appear when there is no more storage space available for

animal numbers or transmitter numbers.
Confirm Machine capacity by choosing in order to view detailed information.
® only 250 animals poss. means: No more free animal numbers are available.

® Transmitter storage full means: No more storage space available for further transmitter

numbers.

You rectify the warning "only 250 animals poss." as follows:

1. Cancel the registration of one or more animals in the Animal menu.
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When you cancel an animal's registration it will not receive any feed. This can
lead to malnutrition. Malnutrition can cause impaired growth and development, increased
susceptibility to illness or even the death of your calves. The end user must use an alterna-

tive method to supply their calves with feed.
2. Confirm delete warning? by choosing J‘

You rectify the warning "transmitter storage full" as follows:

1. Choose > Animal management > Transmitters to go to the Edit submenu.

2. Select the transmitter number to be deleted and confirm Delete by choosing .

Note: You can only delete transmitter numbers of calves that are not registered (= status:
available).

3. Confirm delete warning? by choosing J‘
8.2.12 Check SD card
The Check SD card warning appears in your display:
e |f data is to be saved manually, but no SD card is present.
e |f data is to be saved manually, but the SD card is currently write-protected.
e |f data is to be saved automatically but the SD card is full.

e |f data is to be saved automatically but the SD card is currently write-protected.

8.3 Other faults and messages

8.3.1 Automatic feeder
8.3.1.1 Starting program

The message Smart Vxx.xx starting program appears when the control program of the

automatic feeder starts.
Wait until the automatic feeder is ready to operate.

8.3.1.2 |Initialization of the feeder

The message first startup, press enter to start installation will appear in the display in the

following cases:

® \When the automatic feeder starts for the first time.



122

Faults and warnings

8.3.2

8.3.2.1

8.3.2.2

e |f the computer card must be replaced due to a hardware defect.

Follow the instructions on the screen. The following steps can be performed in the course of

the initialization:

> Restoration of the last backup (if available).
> Entry of the language for the user interface.
> Entry of the current date and time.

Hand terminal

CAN bus off

If a short circuit or electromagnetic discharges negatively affect the CAN cable, the message

terminal Vxx.xx CAN bus off will appear in the display.

You correct the fault as follows:

Check the CAN bus for short circuits and other faults and correct them.
CAN bus heavy

The following faults trigger the message terminal Vxx.xx CAN bus heavy :

® Short circuit.

Terminating resistor not set.

Break in the data line.

CAN cable incorrectly attached.

No connection for automatic feeder control unit.

You correct the fault as follows:

® Check the CAN bus for short circuits.

Check whether the terminating resistor has been properly set.

Check whether the data line has been interrupted.

Check whether the CAN cables are correctly connected.

Check whether the data line is correctly wired and that the feeder control is working.
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8.3.2.3 Waiting

The following faults prevent the hand terminal from initializing:

® The CAN bus address of the terminal is not the same as the one defined in setup of the of

the automatic feeder.
® The feeder control unit is not active.
The message terminal Vxx.xx waiting appears.

You eliminate the faults as follows:

1. Start search mode: Press mmwhen you switch on the feeder and keep this key pressed.

2. When the display reappears, you have to check whether the feeder control is working.

8.3.2.4 Searching

When the hand terminal is in search mode, the message terminal Vxx.xx searchingwill

appear.

You correct the fault as follows:

® Check whether the feeder is working.

® |fthe message is not automatically hidden in about ten seconds, you must check the feeder
control.
8.3.3 Bootloader
8.3.3.1 Waiting for update

The following faults trigger the message bootloader Vxx.xx waiting for update:

® The automatic feeder’s control program is not able to run.

Update the program using an SD card or FlashManagerPlus.

® The bootloader was (accidentally) activated while switching on.

If the bootloader was accidentally started during the start of the automatic feeder by press-
ing and holding , you have to restart the automatic feeder.
8.3.3.2 Flash programming

The message bootloader Vxx.xx flash programming will appear while the program is being

updated.



124

Faults and warnings

8.3.3.3

8.4

8.4.1

Wait until the update has been completed.

Starting program

The message bootloader Vxx.xx starting program will appear when the bootloader for the

automatic feeder starts.

Wait until the program has started.

Service messages

A service message appears in the automatic feeder's display every 4 months. This message
indicates the maintenance (regular service) that must be performed. Compliance with these
maintenance intervals is the only way to ensure the long life and reliability of the automatic

feeder.

The following regular services (RS) have been defined:
® RSI1 must be performed every 4 months.

® RS2 must be performed every 12 months.

® RS3 must be performed every 36 months.

Via Setup > Service > last, check when the last regular service was carried out and in Type,

check what sort of regular service it was (RS1, RS2 or RS3).

Go to Setup > Service > next to check when the next regular service is due and go to Type

to check what sort of regular service is required (RS1, RS2 or RS3).

Service work

For each regular service, there are various service packages (sets of spare parts) with the
spare parts required, which will differ, depending on the type of feeder and type of service.
After replacing the parts subject to wear, you must also check that the feeder is working prop-
erly e.g. the calibration. The service work is described in the installation information for the sets

of spare parts.

You can collect the corresponding service packages (sets of spare parts) via a regular service
configuration tool which is available in the dealer area of Forster-Technik's web site

(www.foerster-technik.de).



Faults and warnings 125

FORSTER
W TECHNIK

A DTN o S

Configurator
Service packages

B

After doing the regular service, under Setup > Service > Serv. done? confirm the message

Use today's date as regular service date? with Ener,

Note: This service message will be shown in the display for 3 days and will then disappear
until the next regular service is due. It can be deleted earlier by pressing @; however, it will

be re-created every day within these 3 days.

8.5 Diagnosis

The Diagnosis menu helps you to find faults in the event of technical problems. You can reach

this menu via EDQ. A diagnosis can be performed for the following parts of the automatic feeder:
® \alves

e Motors

® Heating

® Sensors

e Control system

® \/ersion

® Setup

® Software

8.5.1 Checking valves/motors

In this menu, you check actuators (valves and motors) and their actuation.
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8.5.1.1 Valves

Check the valves as follows:

1. Choose EDQ > Diagnosis to go to the Valves submenu.

2. Confirm Bo. water open? by choosing E™e" to open the water valve. The valve remains

open as long as you hold down ’;

3. Confirm Mixer drain open? by choosing @ to open the mixer drain valve. The valve re-

mains open as long as you hold down \T‘
4. Check whether the valve opens.

8.5.1.2 Motors

Check the motors as follows:

1. Choose > Diagnosis to go to the Motors submenu.

2. Confirm Mixer start? by choosing E™e’ in order to start the mixer.

3. Confirm Start powder? with to start the powder conveyor.

4. Confirm Feeding pump start? by choosing ﬂ in order to start the feeding pump.
8.5.2 Checking the heating

In this menu, you check the boiler heater.

Check the boiler heater as follows:

1. Choose > Diagnosis to go to the Heating submenu.
2. Confirm switch on? by choosing ’;
3. In Boiler, you check the temperature.

4. If you hold down in switch on?, the boiler is heated up. If the temperature rises, the
heater is working.

8.5.3 Checking sensors
In this menu, you check the sensors of the following components:
® Point and rod electrode.

e Button for the manual feeding pump (active/inactive).
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e Mixer and boiler (temperatures of the liquids in the boiler and in the mixer jar).
® \Water meter

8.5.3.1 Point and rod electrode

Check the electrodes as follows:
1. Choose > Diagnosis > Sensors to go to the Rod electrode or Point electrode sub-

menu.
2. In the right-hand column, check the status (free or covered).
3. Confirm Rod electrode or Point electrode by choosing .
3.1 Inthe Status menu, check the status (free or covered).
3.2 Confirm Boiler water start? by choosing @
The electrode will be triggered if water is dispensed into the mixer jar.
3.3 Confirm Mixer: empty? by choosing @ to pump out the liquid again.

8.5.3.2 Button for the manual feeding pump

Check the button as follows:

1. Choose EDQ > Diagnosis > Sensors to go to the MP button submenu.
2. In the right-hand column, check the status (active or inactive).

8.5.3.3 Temperature in the mixer and boiler

Check the temperature of the liquid in the mixer or boiler as follows:

1. Choose EDQ > Diaghosis > Sensors to go to the Boiler or Mixer submenu.
2. Check the temperature in the right-hand column.

8.5.3.4 Water meter
In this menu, you check the water meter.

Check the water meter as follows:

1. Choose EDQ > Diagnosis > Sensors to go to the Water flow meter submenu.

2. In Pulses, you check the pulses from the water meter.

3. Confirm Boiler water with .
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The water meter is actuated when the number of pulses increases.
4. Confirm Mixer: empty? by choosing to pump out the liquid again.
8.5.4 Checking stations
In this menu, you check the feeding box(es).
> You check whether the identification system of the feeding box works.
> You can open the feeding box valve.
> In the display, you can view the control unit assigned to the feeding box.

You check the identification system of a feeding box as follows:

1. Choose EDQ > Diagnosis > Boxes > Feed to go to the Feeding box 1 or Feeding box 2

submenu.
2. To check the identification (antenna test), hold a transmitter near the antenna.
3. In No. 1, you check the transmitter number.
If the transmitter number is not recognized, proceed as follows:
> Check in the setup whether the correct identification system is configured.
> Check that the data lines between antenna and automatic feeder are undamaged.
> Check the setup for the allocation of the station that is causing identification problems.

You check the feeding box valve as follows:

1. Goto EDQ > Diagnosis > Boxes > Feed.
2. Confirm open? for the valve concernedby choosing .
3. Check whether the valve opens.
8.5.5 Control
In this menu, you check the following faults:

® How often the automatic feeder was without power (power failures).

Note: Switching on and off are also considered to be power failures.

® How often the feeder control unit had to be restarted after a program error (Reset).
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e How often the connection to the terminal was faulty.

® How often an error occurred in connection with the database.

® How often the automatic feeder received no response from the identification system.
® How often the minimum temperature in the boiler was not met (heating).

® How often the water test was negative (water shortage).

e How often the mixer could not be drained via the mixer drain valve (mixer emptying).
® How often the heating function was faulty.

® How often erroneous values were provided by the water meter.

® How often faults occurred during automatic cleaning of the mixer(cleaning).

® How often implausible values were reported by the temperature sensors in Boiler and

Mixer.

® How often the temperature of the boiler water was too high. e.g., if the automatic feeder

was supplied with hot water.
® How often a CAN node is registered with the incorrect CAN address (incorrect ID).

® How often the automatic feeder could not switch to automatic mode because, for example,
the liquid and powder feed components were not calibrated (calibration).

® How often the same address has been assigned in the CAN bus to devices (double ad-

dress).
® How often a fault has occurred in connection with the ID chip.
® How often Unknown transmitters have been detected by the identification system.

® How often it has been indicated that an animal number has already been assigned (double

animal no.).
® How often the detergent empty indicator was displayed.

You check the faults as follows:

1. Via EDQ > Diagnosis go to the Control submenu.

2. Select the fault that occurred.
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. In Number, you check how many times the failure occurred.
. In since, you check when the entries were deleted the last time.
. In last on or last at you can determine the day on which or the time at which a
certain event last occurred.
3. Confirm delete? by choosing @ in order to delete the fault message.
8.5.6  Version

In the Version menu, you can check version numbers. The following units have a version num-

ber:

® Feeder

® Processor

® D chip

® Terminal

® |dentifications at existing feeding stations.

® Peripherals

Check the version as follows:

8.5.7

1. Choose EDQ > Diagnosis to go to the Version submenu.
2. Go to the desired submenu and read the version number.

Setup

You can only view the settings in this menu. To make changes, you must open the setup menu.

(see 5 Setup, page 73 and following pages)

You check the setup settings as follows:

8.5.8

1. Choose EDQ > Diagnosis to go to the Setup submenu.

2. Go to the desired submenu and check the settings.

Software

This menu is only intended for the manufacturer's development department.



Faults and warnings 131

8.5.9

Remote maintenance

During the remote maintenance the automatic feeder is operated via the CalfCloud.

1.

2.

Move via > Diagnosis to the submenu remote control.

Click start? to allow the remote maintenance of the automatic feeder.

. Click terminate? to terminate the remote maintenance of the automatic feeder.

. Status shows you the current status of the connection to CalfCloud. Online, offline or re-

connecting can be displayed.

Service-ID shows you the unique Service-ID of the automatic feeder.

Note: The remote maintenance starts after you have keyed in the Service-ID in CalfCloud.
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9 Appendix

9.1

Note: The following checklists and overviews also include additional equipment. If this equip-

ment is not present in your specific case, skip the irrelevant items on the list.

Checklist for commissioning and recommissioning

Note: Before each initial startup or restart of the automatic feeder, you must carefully read and

observe the operating manual, particularly the safety information.

General tasks OK?
1. Inform the end user that the automatic feeder must be installed in a frost-proof location or must be I:l
fitted with frost protection equipment.
2. Inform the end user that he/she must ensure appropriate lightning protection (e.g., lightning protec- |:|
tion system for the entire building).
3. Tell end users that the automatic feeder must be protected from rain and moisture. |:|
4. Tell the end user that the water should be of drinking water quality. Excessive calcium and/or iron |:|
and/or manganese concentrations may cause premature weatr.
5. Tell end users that the hose which goes from the mixer drain valve to the drain shaft may not be I:l
lengthened.
6. Tell end users that the feeder and cables are to be protected against exposure to sunlight. |:|
7. Set up the automatic feeder on an even surface. |:|
8. Electrically ground the automatic feeder. |:|
9. Shorten the drain hoses. |:|
10. Connect water supply. |:|
11. Connect drain. |:|
12. Install feeding box and feeding station. |:|
13.  Attach pushbutton/remote control. |:|
14. Connect antennas and Ethernet cable. |:|
15. © Install concentrate station (including antennas) and fill concentrate container. |:|
16. © Install animal scales: install scale control(s), install weighing platforms in the stands. I:l
17. Install suction hoses. I:l
18. Install safety grid for the powder hopper attachment. I:l
19. Fill MP container. I:l
20. Install the external detergent supply. I:l
21. Check switch setting for heating cable, condensation prevention heating and mixer jar heating. I:l
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22. Connect power supply. |:|
23. Switch on automatic feeder. |:|
24. Fill boiler with water. |:|
25. Reinstall device data. |:|
Setup OK?
1. Switch off automatic feeder at the main switch and switch on again; while doing this press and hold

T

a

2. Check the following settings:

2.1 Language

2.2 Check time/date, set if necessary.

2.3 Machine

2.3.1 Assign number and address.
2.3.2 Determine base size.
2.3.3 Heating activated yes/no — mechanical/electronic relay.

2.4 Equipment

24.1

Mixer drain fitted yes/no.

24.2

© Additive dispenser 1/2 powder or liquid present yes/no.

243

Detergent pump fitted yes/no.

244

© Detergent sensor no/rod.

245

Circulation valve fitted no.

2.4.6

©Air valve (pulsating compressed air cleaning) fitted yes/no.

247

Mixer temperature sensor fitted yes/no.

248

Water meter fitted yes/no.

2.4.9

Point electrode fitted yes/no.

25 Identification

251

Set type.

252

Set squelch value.

2.6 ID chip

2.7  @Calibration scale

2.7.1 Activate yes/no

2.7.2 Adjust.

L0 ooud ooddoooodd ood o O
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2.8 Stations:
2.8.1 Activate internal feeding box(es), controlled by feeder. |:|
2.8.2 @Configure single IFS feeding box(es) / set extras, if any. |:|
For IFS feeding box(es) issue CAN bus addresses: To do this, put IFS (feeding box)
into search mode and then, via search? Assign address.
2.8.3 @Configure quadruple IFS feeding box(es) and issue CAN bus addresses: To do |:|
this, put compact IFS unit into search mode and then allocate address via search?
For each of the four pumps, enter the assignment to station and its equipment.
2.8.4 @ Configure CalfRail and issue CAN bus address: To do this, put CalfRail unit into |:|
search mode and then, allocate address via search?
2.8.5 @Configure IFS concentrate station 1(...). Select concentrate feeder type. Issue |:|
CAN bus addresses: To do this, put IFS (C-station) into search mode and then, via
search? assign address.
2.8.6 @ Configure scale control(s) 1/x. To do this, set the CAN address on the scale con- I:l
trol circuit board via HEX switch and enter the set address in setup. Activate any
weighing units (1/2).
2.9 Terminal:
2.9.1 Assign address |:|
2.10 Communication:
2.10.1 Institute yes/no |:|
2.10.2 Printer no/serial/CAN. I:l
2.10.3 Configure gateway, parameters. I:l
2.10.4 Configure network I:l
Device data OK?
1. Operating modes:
1.1 Set rationed or ad lib mode. |:|
2. Set portion:
2.1  Setthe set and minimum temperature. |:|
2.1 Set output pause. |:|
2.1  Set mixer draining and mixer OFF delay |:|
3. Check time/date. |:|
4. Assign the function keys |:|
5. Specify animal list. |:|
6. Define station parameters:
6.1 Drain time. |:|
6.2 © Check switch on and off delay for gradient or servo control. I:l
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6.3 @ Check start and stop ramps for servo control (for IFS feeding box).

6.4 € Check minimum and maximum speed for servo control (for IFS feeding box).

7. Switch auto-calibration on or off, specify the time of auto-calibration.

8. © Teat slider (close/open after xx min).

9. @ cCalfProtect (open after xx min).

L0 oog

Calibration OK?
1. MP
2. Boiler water

3. © Additive 1/2

4. Detergent

5. © Concentrate stations

6. ©@Hose pumps

oooond

7. © Settings for automatic calibration of MP/water.

Register OK?
1. Antenna test |:|
2. Set the scheme for the transmitter number assignment: consecutive, automatic. |:|
3. Read transmitter numbers. |:|
4, Set registration mode: no, automatic, available transmitter numbers. |:|
5. Register animals. |:|
Plans OK?
Feed

1. Feeding plans

2. Concentrate plans
3. Quantity limitation: check minimum saved amount/maximum saved amount.
4. © Check the maximum speed of the hose pumps and adjust if necessary.

5. Weaning

© Concentrate

1. Concentrate plan

2. Portion size

O |O00 o
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3. Quantity limitation: check minimum saved amount/maximum saved amount.

4. Activate accustoming quantity yes/no.

4.1 Check amount/threshold and adjust if necessary.

L

Change date of individual animals

o

K?

1. Group

2. Feed

3. Concentration
4. © Concentrate

5. © Additive 1 / additive 2

0o oont

6. Weight

7. Plan day (correction days)

Cleaning OK?
1. Check or make settings:

1.1 Temperature, cleaning water

1.2 @ Detergent amount

1.3 Clean teat

2. Mixer

2.1  Drainage mode

3. Cleaning circuit

4, © Air (pulsating compressed air cleaning)
5. Suction hose

6. Perform the cleaning.

oooobtt
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Recommissioning

OK?
1. Set up the automatic feeder. |:|
2. Clean outside of automatic feeder with damp cloth. |:|
3. Fit powder hopper attachment safety grid. |:|
4. Connect water connection of automatic feeder to milk tank using new hose. |:|
5. Put the detergent supply into operation. |:|
6. Connect teat t(_) feeding box valve _(rationed mode_) or to mixer jar (ad lib mode) using new hose. |:|
(Install hose with downwards gradient to automatic feeder).
7. Connect mixer drain valve and the drain channel using a hose. The hose may not be extended. I:l
8. Replace dummy plug and cable opening for Ethernet cable. I:l
9. Remove locks of antenna connections and connect antenna cable. I:l
10. Connect power plug to installed socket and turn on automatic feeder. I:l
11.  Acknowledge the message Fault boiler not filled by pressing g, 0N the hand terminal. I:l
12. Confirm the message Fill boiler in the hand terminal with g, ... I:l
13. Enter the time and date on the hand terminal using [Ijﬂ Device data > Date and time. |:|
14. Run cleaning programs. 7 |:|
15. Fill milk powder (MP). |:|
16.  Perform calibration. |:|
17. Check setup settings. |:|
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9.2 Automatic feeder material list

The materials used in the automatic feeder include:

® Brass, Enzidor®

® Silicon carbide

® Carbon

® V2A, V4A

® Plastics: PET, TPE, silicone, PVC, NBR, ABS, PUR
® Viton

® Vulcanized fiber, graphitized

® Rubber

® Bronze
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9.3 Automatic feeder shutdown checklist

Shutdown

OK?

1. Run cleaning cycle.

2. Drain water from boiler, solenoid valves, pressure valve, and volume control

valve.

21
2.2
2.3
2.4

2.5

Close water tap.

With the hand terminal, via M > Boiler water > Start? dispense water into the mixer jar.
Disconnect water hose between water solenoid valve and boiler.

Open vent screw on boiler cover and drain boiler.

Reattach water hose and tighten vent screw.

Hjin

3. Turn off automatic feeder and disconnect power plug.

4. Disconnect and dispose of water hose.

5. Tip out liquid in mixer.

6. Disconnect hose between teat and feed station valve or mixer. Replace hoses and

teats.

7. Disconnect hose between mixer drain valve and drain channel.

8. Close cable glands of antennas and Ethernet connection with dummy plugs.

9. Close cable glands of Ethernet Connection with dummy plugs.

10.Close antenna connection with locks.

11.Empty milk powder container.

12.@Empty detergent tank.

13.Remove powder container safety grid.

14.Basic cleaning of milk powder container and dosing unit.

15.Clean outside of automatic feeder with damp cloth.

16.Store the devices in a frost-free location, if possible.

L ojojojo ooy ooty oty a
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9.4 Standard feeding plans

Standard Feeding Plan Group A
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* This quantity is not intended as a maximum guantity but as a reference value to calculate
an alarm level.

Standard Feeding Plan

P1:35daysfrom 6to8L F
P2: 35 daysfrom12t02L R

Total: 70 days

Standard Concentration Plan
P1: 70 days from 150 to 150 g/L

Standard Quantity Limitation Plan
P1: 10 days: 1.5 L (Min) 2.0 L {Max)
P2: 25days: 2.0 L (Min} 2.5 L (Max)
P3: 35days: 2.0 L (Min) 3.0 L (Max)

F = AOFIT feeding
R = Restricted feeding

Standard Feeding Plan Group B
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* This quantity is not intended as a maximum quantity but as a reference value to calculate an
alarm level.

Standard Feeding Plan

P1: 7daysfrom 6to 10L R
P2: 28 days from 8to 8L F
P3:40days from12to 2L R

Total: 75 days

Standard Concentration Plan
P1: 75 days from 150 to 150 g/L

Standard Quantity Limitation Plan
P1: 10 days: 1.5 L (Min) 2.0 L {Max)
P2: 25 days: 2.0 L (Min) 2.5 L (Max)
P3: 40 days: 2.0 L (Min) 3.0 L {Max)

F=40FIT feeding
R = Restricted feeding
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Feedin liters/day

Feedin litersfday

w & U m o~ ;W

o = N

Standard Feeding Plan Group C

/ \

R

s W

TG

1 2 5 7 9 111315171921 233253272931333537394143454749 51 535557596163
Plan day

Standard Feeding Plan G

W e W

T g

g

e

e

R

1 4 7 10 13 16 19 22 25 28 31 34 37 40 43 46 45 52 55 58 61 64 67 70 73 76
Plan day

Standard Feeding Plan

P1: 2daysfrom50to5.0L
P2: B daysfrom50to6.0L
P3: 21 daysfrom6.0to 60L
P4:35daysfrom6.0to25L

Total: 64 days =316 L

Standard Concentration Plan
P1: 64 days from 150 to 150 g/L

Total: 64 days =47.4 kg MP
Standard Quantity Limitation Plan

P1:. 14 days: 1.5 L (Min) 2.0 L (Max)
P2: 14 days: 2.0 L (Min) 2.5 L (Max)

(
P3: 36 days: 2.5 L (Min) 3.0 L (Max)

roup D

Standard Feeding Plan

P1: 3daysfrom6.0to6.0L
P2: 14 days from6.0t0o 8.0 L
P3:18daysfrom80to80L
P4:42 daysfrom80to25L

Total: 77 days =478 L

Standard Concentration Plan
P1:77 days from 150 to 150 g/L

Total: 77 days =71.7 kg MP

Standard Quantity Limitation Plan
P1: 14 days: 1.5 L (Min) 2.0 L (Max)
P2: 14 days: 2.0 L (Min) 2.5 L (Max)
P3: 49 days: 2.5 L (Min) 3.0 L (Max)
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9.5

CAN bus addresses

Standard addresses

The following chart shows an example of address assignment based on default values. On the

following page, you can assign completely customized addresses. Copy the template if

needed.

Note: You can assign a number only once.

Note: If possible, do not change the standard addresses.

Hand terminal
Adress 1

Scale 1
Adress 21

Scale 2
Adress 22

Default addresses

01 - 10: Hand terminal
11 - 20: Automatic feeder(s)

21 - 30: Scale(s)

41 - 50: IFS F-station(s)
51 - 60: IFS C-station(s)
61 - 70: IFS-F-station(s) quadr.

71 - 79: CalfRail

IFS F-station 1
Adress 41

Automatic feeder 1

Adress 11

IFS F-station 2
Adress 42

IFS C-station 1
Adress 51

IFS C-station 2
Adress 52

IFS F quadruple 1
Adress 61

IFS F quadruple 2
Adress 62

CalfRail
Adress 72
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Template for custom address assignment

Adress........

Adress........

Adress........

Default addresses

01-10
11-20
21-30
41 - 50
51-60
61-70
71-79

: Hand terminal

: Automatic feeder(s)

: Scale(s)

: IFS F-station(s)

: IFS C-station(s)

: IFS F-station(s) quadr.
: CalfRail

Adress........

Automatik feeder

Adress........

Adress........

Automatik feeder

Adress........

Adress........

Adress........

Adress........

Adress........
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9.6 Measuring the components using test equipment in accordance with national reg-
ulations

All electrical components must be checked regularly for electrical safety in accordance with the
intervals and test methods defined in the national regulations.

If any faults or damage are detected during the inspection, the faulty components have to be
replaced before the automatic feeder can be used again.
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A

Abbreviations 14

Additive dispenser 78

Air valve 79

Alarms 55

Animal control 56

Animal list 41, 51, 64
Assigning animal numbers 89
Auto LED 52

automatic feeder components 13
Automatic feeder overview 8
Automatic feeder versions 7
Automatic mode 53

B

Base size 77

C

CalfCloud 70
Calibrating 42
Automatic calibration 46
Manually calibrating 42
Calibrating using the calibration scale 44
Calibrating without a calibration scale 42
Calibration scale 81
CAN analyzer 84
CAN bus 77
Cancel 94
Group 95
Changing the animal number 90
Changing the transmitter number 90
Circulation valve 79
Cloud 70
Commissioning
Attaching the pushbutton/remote control 30
Connecting antennas 31
Connecting Ethernet cables 33
Filling the boiler 39
Filling the powder container 36
Installing feeding stations 29
Installing stand partition 30
Installing the safety grid 35
Reconfiguring everything 39
Setting offline mode 39
Setting portion 40
Squelch values and identification ranges 31
Switching on the automatic feeder 38
Component check 41
Control 128

D

Data backup 67

to Cloud 69

With SD card 68
Deleting transmitter numbers 91
Detergent lance 37
Detergent pump 79
Detergent sensor 79
detergent supply line 36
Device data 58
Diagnosis 125

Heating 126

Motors 126

Sensors 126

Stations 128

Valves 126

Version 130

Disposal 13
Drain time station parameters 41

E

Electrical connection 12, 28

F

Faults
Boiler not filled 107
Boiler temperature sensor 111
Box/drain valve 113
Calibration 112
Calibration scale 105
Heating 106, 110
ID chip 112
Mixer emptying 109
Temperature too high 106
Water meter 108
Water shortage 107

Frost protection 27, 35

G

Grounding 28

H

Hand terminal 50
Hazard level
Attention 20
Caution 20
Danger 20
Warning 20
Hazards
Chemical burns 19
Corrosion 19
Electrical breakdown 18
Excessive strain 19
Infection 19
loss of stability 19
Poisoning 18
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Short circuit 18
heater 79
Heating 78

ID chip 81

Identification 32

Identification range 32
Important safety information 17
Instruction notices 21

Intended use 17

K

Keypad 51

L

Language 76

M

Managing transmitters 87

Manual functions 51, 58

Marking 55

Material damage 19

Measuring the components using test equipment 145
Mixer drain 78

Mixer temperature sensor 79

N

name plate 9
Navigation 55
Number of feeding stations and animals 13

O

Offline mode 52

Operating modes
Ad lib mode 59
Rationed mode 59

P

Permanent shutdown 100
Plan tendency 55

Portion 58, 61

portion 64

Prohibition notices 21

Q

Qualifications 17

R

Recommissioning 100

Register 92

Registering
Automatic 93
automatic 92
Manual 92

Reset 39
Residual current device 28
Residual risk 17

S

Safety devices

Safety grid for powder hopper attachment 24

Safety temperature limiter 23
Scraper 24

Safety labels 21

SD card 68

Service messages 124
Service technician 17
Service work 124

Setting up the automatic feeder 27
Setup 73

Shutdown 97

Sleep mode 55

Standard feeding plans 141
Symbols 13, 54

T

Technical data 12

Temporary shutdown 97

Time/date 76

Transferring 95

Transmitter 87
Creating transmitter number 88
Deleting the transmitter number 91
Editing transmitter or animal numbers 90
Retrieving transmitter statistics 91

Vv

vapor barrier 35

w

Warning signs 21

Warnings
Address used twice 117
Calibration 118
Calibration scale 118
Check SD card 121
Double animal number 120
ID chip 119
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Identification 116

Incorrect ID 116

Machine capacity 120

Mixer emptying 115

Mixer temperature sensor 116

Unknown transmitters 117
Water connection 28
Water meter 80

Water pressure 29



EC declaration of conformity
according to the EU Machinery Directive 2006/42/EG, Annex Il, 1.A

Manufacturer:
Forster-Technik GmbH,
Gerwigstr. 25

78234 Engen

Person residing within the Community authorised to compile the relevant technical documentation:
Muller Barbara

Forster-Technik GmbH,

Gerwigstr. 25

78234 Engen

Description and identification of the machinery:
Make: Automatic feeder

Type: TAKS- VS1-*, TAP5-VS1-*, VDW5-VS1-*, TAK5-CS1-*, TAP5-CS1-*, VDW5-CS1-*, TAKS5- VH2-*, TAP5-
VH2-*, VDW5-VH2-*, TAK5-CH2-*, TAP5-CH2-*, VDW5-CH2-*, TAK1-KU2-*, TAK5-KR3-*, TAP1-ZM2-*,
TAP2-ZM2-*, VDW1-WA2-*, TAP7-AH2-*

Function: Automatic preparation, heating, and dosing of liquid feeds for young animal feeding

It is expressly declared that the machinery fulfils all relevant provisions of the following EU Directives:

2006/42/EG Directive 2006/42/EG of the European Parliament and of the Council of 17 May 2006 on machinery, and
amending Directive 95/16/EG (recast)

2014/30/EU Directive 2014/30/EU of the European Parliament and of the Council of 26 February 2014 on the
harmonisation of the laws of the Member States relating to electromagnetic compatibility (recast)

97/23/EG (Pressure equipment) Directive 97/23/EG on the approximation of the laws of the Member States concerning

pressure equipment

Reference to the harmonised standards used, as referred to in Article 7(2):

EN ISO 12100:2010-11 Safety of machinery - Electrical equipment of machines - Part 1: General requirements
(1SO 12100:2010)

EN 60335-1:2012/A11:2014 Household and similar electrical appliances - Safety - Part 1: General requirements IEC 60335-1:2010
(modified)

EN 61000-6-2:2005/AC:2005 Electromagnetic compatibility (EMC) - Part 6-2: Generic standards - Immunity for industrial environments

EN 61000-6-3:2007/A1:2011/ Electromagnetic compatibility (EMC) - Part 6-3: Generic standards - Emission standard for residential,
AC:2012 commercial and light-industrial environments

Engen, 20.04.2016 yATAY (.\,w

Place, date Signature
Markus Forster
CEO
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